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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

Avid products or portions thereof are protected by one or more of the following United States Patents: 5,309,528; 5,355,450; 
5,396,594; 5,440,348; 5,467,288; 5,513,375; 5,528,310; 5,557,423; 5,577,190; 5,584,006; 5,640,601; 5,644,364; 5,654,737; 
5,724,605; 5,726,717; 5,745,637; 5,752,029; 5,754,851; 5,799,150; 5,812,216; 5,828,678; 5,842,014; 5,852,435; 5,986,584; 
5,999,406; 6,038,573; 6,141,007; 6,211,869; 6,532,043; 6,546,190; 6,596,031; 6,747,705; 6,763,523; 6,766,357; 6,847,373; 
7,081,900; 7,403,561; 7,433,519; 7,555,557; 7,562,099; D352,278; D372,478; D373,778; D392,267; D392,268; D392,269; 
D395,291; D396,853; D398,912; and 8,082,226. Other patents are pending.

Avid products or portions thereof are protected by one or more of the following European Patents: 0506870; 0635188; 0674414; 
0752174; 1111910; 1629675. Other patents are pending.

This document is protected under copyright law. An authorized licensee of Interplay Assist may reproduce this publication for the 
licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, for 
commercial purposes, such as selling copies of this document or providing support or educational services to others. This document 
is supplied as a guide for Interplay products. Reasonable care has been taken in preparing the information it contains. However, this 
document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not accept 
responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change without 
notice.

Copyright © 2012 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 
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Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.
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The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.

This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Interplay Production Streaming Server includes Live555, which is covered by the GNU Lesser General Public License. “Live555 is 
Copyright (c) 1996-2011, Live Networks, Inc. and is licensed under the terms of the GNU Lesser General Public License, which is 
included with this product.”

This product includes software developed by Indiana University Extreme! Lab (http//:www.extreme.indiana.edu/)/

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid Remote 
Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Axiom, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Boom, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, Conectiv, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, Dazzle, Dazzle Digital Video Creator, D-Command, D-Control, Deko, 
DekoCast, D-Fi, D-fx, Digi 003, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, 
Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, 
DigiSnake, DigiSystem, Digital Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, 
DPP-1, D-Show, DSP Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, 
Expander, ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame 
Chase, FXDeko, HD Core, HD Process, HDPack, Home-to-Hollywood, HYBRID, HyperControl, HyperSPACE, HyperSPACE 
HDCAM, iKnowledge, Image Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, Instantwrite, Instinct, 
Intelligent Content Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording 
Manager, InterFX, Interplay, inTONE, Intraframe, iS Expander, ISIS, IsoSync, iS9, iS18, iS23, iS36, ISIS, IsoSync, KeyRig, 
KeyStudio, LaunchPad, LeaderPlus, LFX, Lightning, Link & Sync, ListSync, LKT-200, Lo-Fi, Luna, MachineControl, Magic Mask, 
Make Anything Hollywood, make manage move | media, Marquee, MassivePack, Massive Pack Pro, M-Audio, M-Audio Micro, 
Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMatch, MediaMix, Media Reader, Media Recorder, MEDIArray, 
MediaServer, MediaShare, MetaFuze, MetaSync, MicroTrack, MIDI I/O, Midiman, Mix Rack, MixLab, Moviebox, Moviestar, 
MultiShell, NaturalMatch, NewsCutter, NewsView, Nitris, NL3D, NLP, Nova, NRV-10 interFX, NSDOS, NSWIN, Octane, OMF, OMF 
Interchange, OMM, OnDVD, Open Media Framework, Open Media Management, Ozone, Ozonic, Painterly Effects, Palladium, 
Personal Q, PET, Pinnacle, Pinnacle DistanTV, Pinnacle GenieBox, Pinnacle HomeMusic, Pinnacle MediaSuite, Pinnacle Mobile 
Media, Pinnacle Scorefitter, Pinnacle Studio, Pinnacle Studio MovieBoard, Pinnacle Systems, Pinnacle VideoSpin, Podcast Factory, 
PowerSwap, PRE, ProControl, ProEncode, Profiler, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, Pro Tools, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, Scorefitter, ScriptSync, 
SecureProductionEnvironment, Serv|LT, Serv|GT, Session, Shape-to-Shape, ShuttleCase, Sibelius, SIDON, SimulPlay, 
SimulRecord, Slightly Rude Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, Solaris, SoundReplacer, SPACE, SPACEShift, 
SpectraGraph, SpectraMatte, SteadyGlide, Streamfactory, Streamgenie, StreamRAID, Strike, Structure, Studiophile, SubCap, 

http://www.apache.org/
http://jcifs.samba.org/
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Sundance Digital, Sundance, SurroundScope, Symphony, SYNC HD, Synchronic, SynchroScope, SYNC I/O, Syntax, TDM 
FlexCable, TechFlix, Tel-Ray, Thunder, Titansync, Titan, TL Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In 
Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, tools for storytellers, Torq, Torq Xponent, Transfuser, Transit, TransJammer, 
Trigger Finger, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Velvet, Video the Web Way, VideoRAID, VideoSPACE, VideoSpin, 
VTEM, Work-N-Play, Xdeck, X-Form, Xmon, XPAND!, Xponent, X-Session, and X-Session Pro are either registered trademarks or 
trademarks of Avid Technology, Inc. in the United States and/or other countries.

Footage
Arri — Courtesy of Arri/Fauer — John Fauer, Inc.
Bell South “Anticipation” — Courtesy of Two Headed Monster — Tucker/Wayne Atlanta/GMS.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Eco Challenge British Columbia — Courtesy of Eco Challenge Lifestyles, Inc., All Rights Reserved. 
Eco Challenge Morocco — Courtesy of Discovery Communications, Inc.
It’s Shuttletime — Courtesy of BCP & Canadian Airlines. 
Nestlé Coffee Crisp — Courtesy of MacLaren McCann Canada. 
Saturn “Calvin Egg” — Courtesy of Cossette Communications. 
“Tigers: Tracking a Legend” — Courtesy of www.wildlifeworlds.com, Carol Amore, Executive Producer.
"The Big Swell" — Courtesy of Swell Pictures, Inc.
Windhorse — Courtesy of Paul Wagner Productions.

Arizona Images — KNTV Production — Courtesy of Granite Broadcasting, Inc., 
Editor/Producer Bryan Foote.
Canyonlands — Courtesy of the National Park Service/Department of the Interior.
Ice Island — Courtesy of Kurtis Productions, Ltd.
Tornados + Belle Isle footage — Courtesy of KWTV News 9.
WCAU Fire Story — Courtesy of NBC-10, Philadelphia, PA.
Women in Sports – Paragliding — Courtesy of Legendary Entertainment, Inc.

News material provided by WFTV Television Inc.

Avid Interplay Software Installation and Configuration Guide • 0130-07635-04 Rev I • Created 9/4/12 • This 
document is distributed by Avid in online (electronic) form only, and is not available for purchase in printed form.

http://www.wildlifeworlds.com
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Using This Guide

Congratulations on your purchase of Avid® Interplay®, a powerful system for managing media in 
a shared storage environment. This guide contains overview installation instructions and 
configuration information for the Interplay components on the Avid Interplay Installer client and 
server installers.

This guide is intended for all Avid Interplay administrators who are responsible for installing, 
configuring and maintaining an Avid Interplay Engine or Avid Interplay Archive Engine 
(database, server, and all related client connections and user rights) in an Interplay workgroup. 

n The documentation describes the features and hardware of all models. Therefore, your system 
might not contain certain features and hardware that are covered in the documentation.

Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

n A note provides important related information, reminders, 
recommendations, and strong suggestions.

c A caution means that a specific action you take could cause harm to 
your computer or cause you to lose data.

w A warning describes an action that could cause you physical harm. 
Follow the guidelines in this document or on the unit itself when 
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the 
order you select them. For example, File > Import means to open the 
File menu and then select the Import command.

This symbol indicates a single-step procedure. Multiple arrows in a list 
indicate that you perform one of the actions listed.

(Windows), (Windows 
only), (Macintosh), or 
(Macintosh only)

This text indicates that the information applies only to the specified 
operating system, either Windows or Macintosh OS X.
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If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published:

- If the latest information for your Avid product is provided as printed release notes, they 
are shipped with your application and are also available online.

- If the latest information for your Avid product is provided as a ReadMe file, it is 
supplied on your Avid installation media as a PDF document (README_product.pdf) 
and is also available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To 
view these online versions, select ReadMe from the Help menu, or visit the Knowledge Base 
at www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/onlinesupport. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to 
read or join online message-board discussions.

Bold font Bold font is primarily used in task instructions to identify user interface 
items and keyboard sequences.

Italic font Italic font is used to emphasize certain words and to indicate variables.

Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action Press and hold the first key while you press the last key or perform the 
mouse action. For example, Command+Option+C or Ctrl+drag.

Symbol or Convention Meaning or Action

http://www.avid.com/readme
http://www.avid.com/onlinesupport
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Interplay Documentation
The following documents describe how to use Avid Interplay:

• Avid Interplay Best Practices — provides an overview of the major Interplay components, 
shows sample configuration diagrams, and describes several of the key features, such as 
setting up a user database and using the Avid Interplay Archive Engine.

• Avid Interplay Software Installation and Configuration Guide — describes how to use the 
Avid Interplay installation programs to install and configure software on the various systems 
that make up a Interplay environment. 

• Avid Interplay Engine Failover Guide — describes how to set up a cluster configuration for 
the Avid Interplay Engine and the Avid Interplay Archive engine. There are two versions of 
this guide: one for SR2500 systems and one for AS3000 systems.

• Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide — describes 
how to administer your Avid Interplay Engine or Avid Interplay Archive Engine and Avid 
Interplay database.

• Avid Interplay Access User’s Guide — describes how to use Interplay Access to browse, 
search, and work with assets in the Avid Interplay database.

• Avid Interplay Assist User’s Guide — describes how to use Interplay Assist for logging, 
archiving, and sending to Playback material in an Interplay environment.

• Avid Instinct User’s Guide — describes how to use the Avid Instinct application to write 
iNEWS stories and put together simple audio and video sequences.

• Avid Interplay Media Services Setup and User’s Guide — Avid Interplay Media Services 
lets you control and automate Transcode, Archive, and ProEncode services.

• Avid Interplay Transfer Setup and User’s Guide — describes how to use Interplay Transfer 
to transfer media to and from another workgroup, send finished sequences to a configured 
playback device, ingest media from a configured ingest device, and perform standalone 
transfers between workstations.

• Avid Service Framework User’s Guide — describes how to use the logging, monitoring, and 
management features of the Avid Service Framework applications.

• Avid Low Res Encode Setup and Configuration — describes how to set up and configure an 
Avid Low Res Encode system. Includes information on updating the bootset, root disk 
image, and configuring a Low Res Encode system to work with CaptureManager.

• Avid Interplay Capture User’s Guide — describes how to use Interplay Capture, a newsroom 
ingest tool that enables automated recordings.

• Avid Interplay Capture Administrator’s Guide — describes administrative concepts, tasks, 
and reference material for Avid Interplay Capture.
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• Avid CaptureManager User’s Guide — describes how to use CaptureManager™ in a 
newsroom environment to coordinate video feeds, schedule feed captures at both high and 
low resolutions, and record late breaking events instantly.

• Avid CaptureManager Installation and Configuration Guide — describes how to set up and 
configure CaptureManager.

All documents are available in PDF form on the Interplay Portal and also on the Avid Knowledge 
Base at www.avid.com/onlinesupport.

Viewing Help and Documentation on the Interplay 
Portal

You can quickly access the Interplay Help, PDF versions of the Interplay guides, and useful 
external links by viewing the Interplay User Information Center on the Interplay Portal. The 
Interplay Portal is a web site that runs on the Interplay Engine.

You can access the Interplay User Information Center through a browser from any system in the 
Interplay environment. You can also access it through the Help menu in Interplay Access and the 
Interplay Administrator.

The Interplay Help combines information from all Interplay guides in one Help system. It 
includes a combined index and a full-featured search. From the Interplay Portal, you can run the 
Help in a browser or download a compiled (.chm) version for use on other systems, such as a 
laptop.

To open the Interplay User Information Center through a browser:

1. Type the following line in a web browser:

http://Interplay_Engine_name

For Interplay_Engine_name substitute the name of the computer running the Interplay 
Engine software. For example, the following line opens the portal web page on a system 
named docwg:

http://docwg

2. Click the “Avid Interplay Documentation” link to access the User Information Center web 
page.

To open the Interplay User Information Center from Interplay Access or the Interplay 
Administrator:

t Select Help > Documentation Website on Server.

http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport


Avid Training Services

15

Avid Training Services
Avid makes lifelong learning, career advancement, and personal development easy and 
convenient. Avid understands that the knowledge you need to differentiate yourself is always 
changing, and Avid continually updates course content and offers new training delivery methods 
that accommodate your pressured and competitive work environment.

For information on courses/schedules, training centers, certifications, courseware, and books, 
please visit www.avid.com/support and follow the Training links, or call Avid Sales at 
800-949-AVID (800-949-2843).

http://www.avid.com/support


1 Installation Overview

This document describes how to use the Avid Interplay Server Installer and the Avid Interplay 
Client Installer to install the various Interplay components. Instructions include the order in 
which to install items and any special considerations when you are combining services and 
applications on the same system. 

See the installation check lists for the steps required to install the Interplay products.

This chapter includes the following topics:

• Using the Interplay Installers

• Copying the Interplay Installers to a Server

• Creating a Recovery Image for the AS3000

• Upgrading Your System 

• Installation Check Lists

• Set Up and Configure an Avid Shared Storage System

• Network Considerations

• User Names and Passwords Required For Avid Shared Storage and Product Servers

• Required Application Keys

Using the Interplay Installers
Starting with Interplay v2.7, Interplay installers are delivered on the Avid download center. See 
the Interplay ReadMe for additional information. There are two separate Interplay Installers: one 
for Interplay Servers and one for Interplay Clients. You use the Interplay Installers to install 
Interplay software components on the various servers and clients. 

For Avid editing applications such as Media Composer, use the individual installers for the 
various Avid editing applications and then use the Interplay Client Installer to install the software 
required to make the Avid editing application a client in the Interplay environment. 

n The application software for Avid Interplay Assist and Avid Instinct® is on the Avid Interplay 
Client Installer.
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Additional Installers on the Interplay Installers

The following installers are included on the Interplay Installers, although they are not accessible 
through the Installer user interface. You can browse the appropriate installer folders and select 
individual installers.

• Interplay Servers Installer

- Avid Low Res Encode software. For more information, see “Installing and Configuring 
Avid Interplay Low Res Encoder Software” on page 65.

- Avid Service Framework Workstation Service. See “Installing the Avid Service 
Framework Workstation Service” on page 75.

- Interplay Stream Publish Service and Auto-Publish Support. For more information, see 
“Installing the Stream Publish Service and Auto-Publish Support” on page 65.

• Interplay Clients Installer

- Installer for Mac® OS® X applications. For more information, see “Macintosh Installer 
for Interplay Access” on page 71 and “Installing Software on Avid Editing Systems 
(Macintosh)” on page 87.

Copying the Interplay Installers to a Server
This topic provides instructions for copying the Interplay Installers to a server so that you have 
easy access to installer files if you should ever need them in the future. In this topic, the folder 
that contains the software installation files is referred to as the software kit.

To copy the Interplay Installers to a server:

1. Log in as Administrator. 

2. Make a folder for the software kit on the root directory (C:\) For example:

C:\Installers\Interplay_v2_5_Servers

3. Open the folder containing the installer.

4. Copy the software kit into the new folder you created. For example, use CTRL-A to select 
all the files and folders in the software kit and copy and paste to the new folder you created.

5. Navigate to the software kit folder and double-click the Autorun.exe file.

The Interplay Installer splash screen opens.

6. Install the application as described in this guide.
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Creating a Recovery Image for the AS3000

The Interplay Servers Installer includes a tool for creating a recovery image for the AS3000 
server.

The location of your AS3000 recovery image depends on the Windows OS and the Avid 
application.

• On Windows 7 systems, the recovery image is on the 16 GB flash drive that ships with the 
AS3000 server. Store the flash drive in a safe place.

• For all other systems, the recovery image ships on the D: partition of the system drive. On 
these systems, a tool for copying the image to a USB flash drive is located in the following 
locations:

- C:\Avid_Recovery_Tool\AvidRecoveryImageTool.exe

- <Interplay Server Installer>Utilities\AvidRecoveryImageTool.exe

For instructions on how to use the tool, see the Readme in the corresponding folder or see the 
AS3000 Setup Guide.

c For systems that ship with the recovery image on the D: partition, Avid highly recommends 
you copy the image to the 16 GB USB flash drive provided with your AS3000.

c When you perform a full product recovery of the Avid AS3000 system drive, you lose the 
product recovery image and data on the D: partition of the system drive.

Upgrading Your System

c Before you begin, see the Avid Interplay ReadMe for specific instructions on upgrading for 
a particular release.

The following items apply to upgrading the components on your Interplay system:

• Back up your Interplay database and any other user data before you upgrade. For 
information on backing up your database, see the Avid Interplay Engine and Avid Archive 
Engine Administration Guide.

• Use the Interplay Installer software to uninstall the previous versions of software 
components. You do not have to use the Control Panel to uninstall unless specifically 
instructed to do so in the Interplay Readme.

• Do not uninstall the Avid Interplay Engine or Interplay Archive Engine software unless 
instructed by Avid support. Uninstalling the software could require additional steps to 
reactivate your database. When upgrading, the installation software takes care of removing 
the previous version of the software.
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Updating Intel Drivers on Cluster Systems

Do not install or update Intel NIC drivers on cluster systems after the cluster setup is complete. 
Due to the technical aspects of changing resources and devices on a cluster, this can lead to 
problems with the cluster software and possible data loss.

Deleting the Intel drivers on an establised cluster system could compromise the integrity of the 
cluster. In general, do not update the hardware drivers on a cluster system unless instructed to do 
so by the Interplay Readme or Customer Support.

n If you are reimaging the system as part of an upgrade then you can take the opportunity to 
update the Intel NIC drivers at that time.

Installation Check Lists
This section contains the following check lists:

• Overall Interplay Installation Check List

• Media Indexer Installation Check List

For information about installing the Interplay Streaming Server, see “Check List for Installing 
and Configuring the Streaming Server Software” on page 138.

Overall Interplay Installation Check List

The following check list provides an overall view of an Interplay installation.

Check List for Installing Interplay Components

Task Section Reference

 Review the recommendations in the Avid Products and 
Network Site Preparation Guide.

 Determine your Media Indexer server configuration. See the Avid Interplay Best Practices guide.

 Determine where the Avid Lookup Service is running 
or where it will run. The Lookup service is part of the 
Avid Service Framework.

See “Installing the Lookup Service on a 
Separate Server” on page 120, and 
“Connecting Systems Directly to the Lookup 
Service” on page 122.

 If you use AirSpeed Multi Stream or AirSpeed 5000 
systems, refer to the associated installation guides.

See the Avid AirSpeed 5000 Setup Guide or 
the AirSpeed Multi Stream Installation and 
User’s Guide.
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 If you use AirSpeed® or CaptureManager to capture 
media, determine where you will install the Interplay 
Adapter.

See “Interplay Adapter and AirSpeed” on 
page 125.

 If you are using Media Services providers such as 
Interplay Transcode or an Interplay Archive Engine, 
determine where your Interplay Media Services 
Engine server will reside and where you Media 
Services providers will reside.

See the Avid Media Services Setup and User’s 
Guide.

 Check your network environment. See “Network Considerations” on page 24.

 Set up the servers that will be used in your Interplay 
environment.

See the following:

• Migrating Interplay Applications to 
AS3000 Servers 

• “SR2500 Slot Locations” on page 161

• “Configuring the Copy Provider Server” on 
page 165

• “Installing and Configuring the Interplay 
Streaming Server” on page 131

• “Avid Interplay Port Usage” on page 183

 If you will be setting up a cluster (failover) 
configuration of the Avid Interplay Engine or Avid 
Interplay Archive Engine, set up the cluster system.

See the Avid Interplay Engine Failover Guide 
or the Avid Interplay Engine Failover Guide 
for AS3000 Servers.

 Set up and configure your Avid ISIS™ or Avid Unity™ 
system.

See “Set Up and Configure an Avid Shared 
Storage System” on page 23 and “User Names 
and Passwords Required For Avid Shared 
Storage and Product Servers” on page 27. 

 Create a Server Execution User account for the 
Interplay Engine. 

See “Creating the Server Execution User 
Account” on page 27.

Check List for Installing Interplay Components

Task Section Reference
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 On the Interplay Engine server, use the Interplay 
Servers Installer to install the Interplay Engine and 
related software.

n Make sure that you obtain and load the 
Interplay Engine license key promptly. The 
license key must match the dongle for the 
Interplay Engine server. For more information, 
see the Avid Interplay Engine and Avid 
Interplay Archive Engine Administration 
Guide.

See “Installing Software on the Interplay 
Engine Server” on page 35.

 Install and configure the Media Indexers that will 
monitor shared storage.

See “Media Indexer Installation Check List” on 
page 22.

 At this point you can install and configure the 
following applications in any order:

• Install the Interplay software components for the 
Avid editing applications.

See “Installing Software on Avid Editing 
Systems (Windows)” on page 74. See 
“Connecting the Media Indexer on an Avid 
Editing System to the Media Indexer 
Monitoring Shared Storage” on page 77.

• Install the Interplay software components and 
application software for Avid Instinct and Avid 
Interplay Assist.

See “Installing Software on Interplay Assist or 
Avid Instinct Systems” on page 69.

• Install and configure Interplay Transfer Engine. See “Installing Software on the Interplay 
Transfer Server” on page 48.

• Install and configure the Media Services Engine. See “Installing Software on the Media Services 
and Media Services Provider Servers” on 
page 49.

• If your site is using the Media Services Copy 
provider, install and configure the Copy Provider 
server. and Move Provider server

See “Configuring the Copy Provider Server” 
on page 165 and “Configuring the Move 
Provider Server” on page 176.

• If your site is using the Interplay Streaming Server, 
install and configure the Streaming Server and 
related software.

See “Installing and Configuring the Interplay 
Streaming Server” on page 131 and “Check 
List for Installing and Configuring the 
Streaming Server Software” on page 138.

Check List for Installing Interplay Components

Task Section Reference
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Media Indexer Installation Check List

The following check list provides the main installation and configurations steps for Media 
Indexers in an Interplay Environment.

• Install and configure Interplay Capture or 
CaptureManager™.

See the following:

• Avid Interplay Capture Installation and 
Administration Guide

• “Installing Software on the 
CaptureManager Server” on page 64 and 
the Avid CaptureManager Installation and 
Configuration Guide.

• Install and configure the Archive Engine. This is 
similar to installing and configuring an Interplay 
Engine as described earlier in this section.

See “Installing and Configuring an Interplay 
Archive Engine” on page 109.

 Create the Interplay database. See “Creating an Interplay Database” in the 
Avid Interplay Engine and Avid Interplay 
Archive Engine Administration Guide.

 Create Interplay users and folder structures to match 
your project workflow and define a delete strategy.

See “Setting up a Folder Structure and a User 
Database” and “Developing a Delete Strategy” 
in the Avid Interplay Best Practices guide.

 Review the ISIS and Interplay maintenance 
procedures.

See the Interplay Best Practices Guide.

Check List for Installing Interplay Components

Task Section Reference

Check List for Installing Interplay Components

Task Section Reference

 Determine your Media Indexer server configuration. See “Configuring Avid Interplay Media 
Indexers” in the Avid Interplay Best Practices 
guide.

 If you are upgrading 32-bit Media Indexers to 64-bit 
versions, see the upgrade procedure in the Avid 
Interplay Best Practices guide.

See “Replacing 32-bit Media Indexers in the 
HAG with 64-bit Media Indexers” in the Avid 
Interplay Best Practices guide.
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Set Up and Configure an Avid Shared Storage 
System

Before you install Interplay software, install and configure your Avid shared storage system for 
shared storage. See the Interplay ReadMe for the supported versions of Avid ISIS and Avid 
Unity MediaNetwork.

Depending on whether you have Avid Unity MediaNetwork or Avid ISIS, install the Connection 
Manager (MediaNetwork) or Client Manager (ISIS) on the client systems.

 Use the Interplay Installer to install the client Service 
Framework software. 

n When you install the Service Framework 
software, you must name your workgroup. The 
name is case sensitive and should not contain 
spaces. You can either choose a useful name or 
use the default, AvidWorkgroup. The only time 
you are required to supply a unique name is 
when you have more than one Interplay 
workgroup on the same network. 

 Install the Media Indexer software. See “Installing Software on an Avid Interplay 
Media Indexer Server” on page 57.

 Verify that the Service Framework is running. See “Verifying that the Service Framework 
Services Are Running” on page 103.

 Before you configure the Media Indexer software, 
make sure there is an Avid MediaFiles directory on 
each workspace that the Media Indexer will monitor. 
You can use an Avid editing system to capture or 
import media to the workspace. You can also create 
the directory manually but, if you do, carefully check 
the spelling and case of the text in the folder name.

 Configure the Media Indexers in the High Availability 
Group to monitor your shared storage. You must use 
UNC paths to identify the shared storage folders.

See “Configuring a Media Indexer to Monitor 
Shared Storage” on page 59.

 If you are configuring 64-bit Media Indexers, 
see the Avid Interplay Best Practices guide.

Check List for Installing Interplay Components

Task Section Reference
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Workspace Names

Use the following guidelines when creating workspace names in an Interplay environment:

• Do not use special characters or spaces in your workspace names. Workspace names should 
only contain ASCII characters.

• Keep workspace name length as short as is reasonable to allow recognition of the 
workspace. Longer workspace names add to the path length and can affect performance in a 
large Interplay environment.

Network Considerations

This section contains topics related to setting up your Interplay network environment.

Computer Names

A hostname must comply with RFC 952 standards. For example, you cannot use an underscore 
in a hostname. For more information, see “Naming Conventions in Active Directory for 
Computers, Domains, Sites, and OUs” on the Microsoft® Support Knowledge Base. See also 
“Workspace Names” on page 24.

Verify Entries on the DNS Server

Service Framework can become sluggish and unstable if there are incorrect entries in the DNS 
server for any of the computers in the Interplay environment. Symptoms include excessive CPU 
usage by the Service Framework Lookup service and Interplay Diagnostics. The tree view in the 
Interplay Service Configuration or Health Monitor might also fail to populate if there are 
incorrect DNS entries.

Make sure that you correct any errors in DNS entries for name to IP resolution.

Configure the DNS Server to Support Reverse Lookup

If DNS is not configured for Reverse Lookup, Service Framework can not resolve IP addresses 
to host names. Symptoms include tree views failing to populate in the Interplay Service 
Configuration, Interplay Diagnostics, and Health Monitor.

Make sure the DNS server is configured to support Reverse Lookups.

Non-DNS Environments

In an non-DNS environment, you must configure a host file on all systems, including Avid Low 
Res Encode systems. This is necessary so the Service Framework can list the systems in its client 
applications, such as the Interplay Service Configuration or Health Monitor. 
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Computers with Multiple Network Interfaces

Computers that have multiple network interfaces in use must be entered in DNS so that all IP 
addresses have the exact same hostname.

If you have multiple network interfaces on a computer and one is not used, use the Device 
Manager to disable the interface. If not, the computer might have problems communicating with 
the rest of the Interplay workgroup.

Configuring an Avid ISIS System

On an Avid ISIS system, if your network extends outside of ISIS Zone 1, you must configure a 
router to communicate between the two VLAN® systems.

Know Where Your Subnets Are on the Network

Create a system diagram that identifies the subnets on your Avid Interplay environment. Use 
Unicast Discovery to allow Interplay clients to communicate across subnets. See “Connecting 
Systems Directly to the Lookup Service” on page 122.

n The Multicast Repeater service is available on the Avid Service Framework installer but the 
service is no longer recommended. Use Unicast Discovery instead.

Diagnosing Service Framework Problems

Use the System Check tab of the Avid Workgroup Properties tool to detect and diagnose 
problems in your Interplay environment.

Install Antivirus Software and Check Firewalls

See “Using Antivirus Software in an Interplay Environment” on page 114 and Troubleshooting 
Firewalls and Avid Interplay.
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Time Synchronization

If you already have a system in place to maintain Time Sync on your network, you can continue 
to use that system, or you can use the Service Framework Time Synchronization service to 
perform the same task. 

The Avid Time Synchronization Service enables time synchronization between different 
machines in a workgroup. The Time Synchronization Service can operate in either Master mode 
or Slave mode. In Master mode, the service retrieves a reference time from a configured time 
source and redistributes it to the Slave services within the workgroup. The time source can be the 
local PC clock, an NTP server, or an Adrienne™ timecode card installed in a server, such as the 
CaptureManager server. In Slave mode, the Time Synchronization Service listens for time 
notifications from the workgroup and (optionally) sets the local PC clock to match.

It is important to use only one time synchronism mechanism to set the local PC clocks in the 
Interplay environment. If a Time Synchronization Slave service is configured to set the local PC 
clock and it detects that some other mechanism (such as Windows® 32 Time Services) changes 
the local clock, then the Time Sync Slave service disables itself to avoid the local clock from 
jumping back and forth. The Time Sync slave also posts a Warning in the Health Monitor.

For more information on Time Sync, see “Using Time Synchronization in an Avid Interplay 
Environment” on page 117 and the Service Framework ReadMe at the top level of the Interplay 
Installer or on the Knowledge Base.

Using AirSpeed and Low Res Encode

When using Avid AirSpeed and Avid Low Res Encode to perform a dual ingest, it is important 
that you lock your video signal to your timecode source. For example, you can connect a video 
feed and a Time of Day timecode device into a sync device to lock the incoming video and audio 
with timecode. 

It is also important that the two capture devices are in sync. If the captured high-res video and 
low-res video are off by a few frames, you should delay the video signal going to one of the 
capture devices in order to ensure that the two video signals match. For more information, see 
Avid Interplay Low Res Encode Setup and Configuration. This document is on the Avid Interplay 
installer. 

See “Installing and Configuring Avid Interplay Low Res Encoder Software” on page 65.
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User Names and Passwords Required For Avid 
Shared Storage and Product Servers

Some Avid products require user accounts on the Avid shared storage system. The user names 
and passwords on the Avid shared storage system must match the user names and passwords on 
the product server. If you are using a PortServer for Avid Unity MediaNetwork, these user 
accounts must also have the same accounts and passwords on the PortServer system.

n Passwords are case sensitive; the passwords must match exactly.

Creating the Server Execution User Account

When you install the Interplay Engine software you must specify the user name and password of 
the Server Execution User account. The Server Execution User is a Windows operating system 
user account that is used only to run the Interplay Engine processes. 

n You should always use the Custom install option when installing the Interplay Engine software 
so that you can specify the Server Execution User.

You have the following options for creating the Server Execution User:

• If your Interplay system is joined to a Windows domain, you can create a domain user (for 
example, “IPEngine”). The Interplay Engine installer will associate the appropriate 
permissions with the account. If you want to run the Avid Interplay Engine within your 
domain and also want to automatically make use of domain user management, such as 
Windows Domain or LDAP, you must specify a domain user as the Server Execution User.

For Interplay Engine failover cluster systems, you must specify a Windows domain user. 

• You have the option of allowing the Interplay Engine installer to create the account. Select a 
name before the installation and specify the name and a password during the installation. 
The installer will create a local user in the Administrators group with the appropriate 
permissions.

• You can also create a local Administrator account manually and specify that account during 
the installation. The account must have local administration rights on the operating system 
for the Interplay Engine server (both nodes on a cluster system). The account must have the 
following local security policy settings set to enabled:

- Act as part of the operating system

- Back up files and directories

- Restore files and directories

- Adjust memory quotas for a process

- Log on as a service
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- Increase scheduling priorities

- Manage auditing and security log

- Impersonate a client after authentication

- Debug programs

An account with an identical user name and password must have read/write access to the Avid 
shared storage workspaces that contain media (including the workspace used for file asset 
sources in a split database). Use the Avid ISIS or Avid Unity MediaNetwork Administration tool 
to create this account.

c When you install the Interplay Engine or the Interplay Archive Engine, do not select the 
default Server Execution User. Create a custom user instead. The default user account is 
AVID_WORKGROUP_USER. Do not use this account.

Ideally the Server Execution user should be an account that users do not use to log onto the 
system. This prevents accidental changes to the Server User Account during normal 
administration duties. For example, if someone changes the password by mistake, users might 
not be able to access the Interplay database.

For security reasons, do not use the Interplay Engine server operating system Administrator 
account. Create a unique account that you use only as the Server Execution User. For example, 
you can create an administrative account called “IPEngine.” Avoiding the word Administrator 
can help indicate that this account is not used for normal administrative tasks.

n The Server Execution User account is different from the Interplay Administrator account. The 
Server Execution User account is used to run the Interplay Engine processes. The Interplay 
Administrator account is used to manage users and the database.

For more information, see “Troubleshooting the Server Execution User Account” in the Avid 
Interplay Engine and Avid Interplay Archive Engine Administration Guide.

Recreating the Server Execution User

If you have already installed the Interplay Engine and need to change the user name and 
password of the Server Execution User account, run the NXNServerUser.exe tool. For 
information on using the tool, see “Re-creating the Server Execution User” in the Avid Interplay 
Engine and Avid Interplay Archive Engine Administration Guide.  The tool is located in the 
following directory on the Interplay Installer:

Installers\AssetMgr\Tools\NXNServerUser

For information on upgrading a cluster system on which you changed the Server Execution User, 
see the Avid Interplay ReadMe. 
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Accounts for Copy Provider and Interplay Streaming Server

See the following sections for details:

• “Creating Copy Provider User Accounts for ISIS and Interplay” on page 174

• “Check List for Installing and Configuring the Streaming Server Software” on page 138

Accounts for Accessing Workspaces

To allow the Interplay Engine to access the Avid shared storage workspaces, you need to set up 
user accounts on both the Interplay Engine and the Avid shared storage system. The user name 
and password for these user accounts must match exactly on both the Interplay Engine and Avid 
shared storage system. If the user names or passwords are different, the workspaces are not 
available in Interplay Administrator settings, such as the Media Creation workspace in the Editor 
Settings tab of the Application Database Settings.

The workspaces available from the Interplay Administrator settings depends on the user account 
used to log in to the Interplay Administrator. For example, when you log in to the Interplay 
Administrator server using the Administrator account, you can access all the Avid shared storage 
workspaces, provided the users are set up correctly on both the Interplay Engine and Avid shared 
storage system.

To access all workspaces:

1. Make sure the Administrator account on both the Interplay Engine and Avid shared storage 
system have exactly the same password. Passwords are case sensitive.

2. Log in to the Interplay Administrator server using the Administrator account.

To access a limited list of workspaces:

1. Make sure a user account with administrator privileges is created on the Interplay Engine 
and the same user name and password are used to create a user account on the Avid shared 
storage system. These user accounts must have exactly the same user name and password.

2. Log in to the Interplay Administrator server using this user account.

The Avid shared storage user’s workspace access privileges setting determine which 
workspaces are available.
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Accounts for Using Deletion

To allow deletion in an Interplay environment, you must set up the following user accounts. You 
can use any user name and password for these accounts, but the user name and passwords must 
match exactly on all servers.

• Avid shared storage system

- Avid shared storage user with administrator privileges for Interplay Engine. This user 
must not be the Administrator account.

• Interplay Engine server

- Microsoft Windows user with administrator privileges

- Interplay Engine Server Execution user

When installing the Interplay Engine on the Interplay Engine server, select the Custom 
User Account option to create the Avid Interplay Engine Execution User. The Server 
Execution User is the Microsoft Windows user that runs the Avid Interplay Engine (the 
Avid Interplay Engine Execution User). This user needs to have administrative access to 
the file server. The installer makes this user a local administrator on the Avid Interplay 
Engine server. For more information, see “Creating the Server Execution User Account” 
on page 27.

Accounts for Using AirSpeed Server

When you are adding an Avid AirSpeed server in an Interplay workgroup, the Interplay Engine 
server needs a Windows user account (with Admin rights) with the user name airspeed and 
password avid. You must use these exact user and password names. For additional information, 
see “Configuring Avid AirSpeed” on page 124.

Accounts for Using Interplay Transfer

When you are configuring an Interplay Transfer Engine you must specify a user name and 
password that Interplay Transfer should use to connect to the Avid Interplay engine. This user 
account must already exist on the Interplay Engine.

Service Framework Administrator Password

By default the Service Framework does not have an Administrator password. If you want to set a 
password, open the Service Framework Service Configuration tool and set the password in the 
System Configuration Service.
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To set the Service Framework password:

1. Open the Service Configuration tool and click the Processes tab.

2. Select the System Configuration service and select the system running the System 
Configuration service.

3. Set the Administrator password and click Apply at the top of the dialog box.

Accounts for Avid Editing Applications, Assist, and Instinct

The following limitations exist for editing clients in an Interplay environment:

• Avid editing applications such as NewsCutter®, Media Composer®, and Symphony™ Nitris® 
that are part of an Interplay environment can use a regular Windows User login. However, 
when you install the application, you must first log in as an Administrator, install the 
application, and initially launch the application as an Administrator. See the Avid editing 
application ReadMe for details.

• Interplay Assist and Instinct have similar limitations: When you install the application, you 
must first log in as an Administrator, install the application, and initially launch the 
application as an Administrator. You can then subsequently run the application as a regular 
User. 

• In Avid Unity MediaNetwork, do not use the same login to log into Windows and to log into 
the Connection Manager for Avid Unity MediaNetwork. For more information, see the 
Interplay ReadMe.

See “User Names and Passwords Required For Avid Shared Storage and Product Servers” on 
page 27. Check the Interplay ReadMe for any changes to the Windows login permissions. 

Required Application Keys
The following systems require a hardware application key (also known as a dongle):

• Interplay Engine server - also requires a software application key. For more information, see 
“Installing Software on the Interplay Engine Server” on page 35.

• Interplay Media Services

• Interplay Transfer

n When installing the Interplay Transfer Engine in a standalone environment, a hardware 
application key is not required. The Avid editing software handles the licensing of the Interplay 
Transfer Engine.

• Interplay Transcode provider system (for any Transcode provider that is not run on the 
Interplay Media Services system)
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• Interplay Archive provider (for any Archive provider that is not run on the Interplay Media 
Services system)

• Avid editing applications

c Do not lose the USB application key. Your software does not function without it. If you lose 
your application key, you must purchase another key from Avid at the full market cost of 
your software.



2 Installing Software on Interplay Servers

The following topics describe the installations of the Interplay software on the servers:

• Selecting the 32-Bit or 64-Bit Version of Avid Service Framework

• Starting the Interplay Server Installer

• Installing Software on the Interplay Engine Server

• Installing Software on the Interplay Transfer Server

• Installing Software on the Media Services and Media Services Provider Servers

• Installing Software on an Avid Interplay Media Indexer Server

• Installing Software on the CaptureManager Server

• Installing and Configuring Avid Interplay Low Res Encoder Software

For information on the order of installation and configuration, see “Installation Check Lists” on 
page 19.
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Selecting the 32-Bit or 64-Bit Version of Avid Service 
Framework

The following are 64-bit applications and require the 64-bit version of Avid Service Framework:

• Interplay Transcode Provider v2.5 and later

• Interplay STP Encode Provider v2.5 and later

• Interplay Media Services Engine v2.7 and later

• Interplay Copy v2.7 and later

• Interplay Move v2.7 and later

• Interplay Delivery v2.7 and later

• Avid Media Composer v6.0, Symphony v6.0, NewsCutter v10.0 and later

• Interplay Assist v2.5 and later

• Instinct v4.0 and later

The other Interplay applications that require the Framework are 32-bit applications and can run 
with either the 32-bit version or the 64-bit version of Avid Service Framework.

To run a 32-bit applications with the 64-bit Service Framework:

1. If the 32-bit Framework is installed on the system, use the Add/Remove Programs tool to 
uninstall it.

2. Install the 64-bit Framework. Make sure to install the client or server version as appropriate.

3. Click the Lookup tab and check whether the system is connected to the Lookup Service. If it 
is already connected, you can close the Workgroup Properties tool.

4. If the system is not connected to the Lookup Server, connect it as follows:

a. Select the Workgroup that you want to connect to and click Add in the Lookup services 
window.

n If the name of the workgroup that you need does not appear in the Workgroup area, click the Add 
button and add the entry. Remember that the name is case sensitive.

b. In the Lookup Service dialog box, type in the fully qualified domain name of the system 
running the Lookup service.

c. Click Expected and click OK.

Besides identifying the Lookup Server system, launching the Workgroup Properties tool defines 
the settings in the Windows registry that allow 32-bit applications to locate the 64-bit 
Framework.
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Starting the Interplay Server Installer
To start the Interplay Server Installer:

1. In the Interplay Server Installer folder, double-click autorun.exe.

The Main Menu window opens.

The Main Menu window allows you to select the installers required by a particular Interplay 
component. The list is divided into Interplay servers and individual optional installers. 

n Items with three dots open a new window. Items without three dots start an installer.

Installing Software on the Interplay Engine Server
These instructions are for a system with a single Interplay Engine or Interplay Archive Engine. If 
you are installing software on a system with cluster services, see the Avid Interplay Engine 
Failover Guide.

c If you are upgrading an Interplay Engine, see the Interplay ReadMe before proceeding. 
The Readme contains any specific instructions for upgrade the Interplay Engine for a 
particular release.
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To install the Interplay Engine Server:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Engine

2. Install components from the following table:

3. Perform the installation in the order shown in the above list. You have to reboot the server 
after the Interplay Engine installation.

Avid Unity MediaNetwork Compatibility with the Interplay Engine

Starting at Interplay v2.2, the Interplay Engine requires an updated version of the 
UnityAecifsLibVC7.DLL that is installed as part of a MediaNetwork client installation. The 
updated version of that DLL is UnityAecifsLibVC9.DLL. 

This has the following implications for MediaNetwork sites:

• If any version of the MediaNetwork client is already installed on the server on which 
Interplay Engine 2.2 is to be installed, the Interplay Engine installer will automatically 
install the new .dll. No further action is required.

• If Interplay Engine 2.2 is to be installed on a fresh server in a MediaNetwork environment, 
you must install the MediaNetwork client before installing the Interplay Engine.

Installing the Avid Interplay Engine Software

The first time you install the Avid Interplay Engine software, you must select Custom 
installation. Selecting Custom installation lets you specify the Server Execution User and other 
configuration information correctly.

If you are upgrading, you should also use Custom installation to verify that the settings are 
correct. For example, during a Custom installation you can verify the name of the Server 
Execution User. 

n If you are installing or upgrading a cluster system, see the Interplay ReadMe and the Avid 
Interplay Engine Failover Guide.

Component Description

Avid Interplay Engine The full Interplay Engine software. See “Installing the Avid Interplay 
Engine Software” on page 36.

Avid Interplay Access Required to communicate with the Interplay Engine database. Installing 
Interplay Access also installs the Interplay Administrator. See 
“Installing Avid Interplay Access” on page 47.
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n If you are installing an Interplay Archive Engine, see “Installing and Configuring an Interplay 
Archive Engine” on page 109.

To install the Avid Interplay Engine software:

1. Before you begin, do the following:

t Make sure that the Interplay Engine application key is installed on the server system. 
For more information, see “Required Application Keys” on page 31.

The Interplay Engine also requires a software license. Install this license after installing 
the Interplay Engine software, as described at the end of this procedure.

t Make sure you have created matching accounts on the Interplay Engine system and the 
Avid shared storage system. You need to type the user name and password during 
installation to create the Server Execution User. See “Creating the Server Execution 
User Account” on page 27.

t Close all Windows programs.

2. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Engine > Avid Interplay Engine

3. In the Welcome dialog box, read the information about the installation of the Apache server. 
Click Next.

4. Read the license agreement information and then accept the license agreement by selecting 
“I accept the agreement.” Click Next.

The Specify Installation Type dialog box opens.

5. Select one of the following and click Next:
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t If this is a new installation, select Custom. This ensures that you identify the Server 
Execution User required by the Interplay Engine. 

n Avid recommends that you always use the Custom installation option so that you can view the 
Server Execution user name and review other settings as you proceed with the installation.

t If this is an upgrade, select Typical and proceed to step 18. (Both the Typical and 
Custom installation use the existing settings.)

The Specify Destination Location dialog box opens.

6. Specify the destination folder and click Next.

The Destination Location is the folder in which the Avid Interplay Engine program files are 
installed. In most cases, keep the default, which installs the files in an Avid Interplay Engine 
subfolder in the Program Files folder.

The Specify Default Database Folder dialog box opens.
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7. Accept the default folder and click Next.

The database folder is the folder in which the database is created and stored. This location 
must be local, that is, the database folder must be installed on the Interplay Engine server. 
No other configuration is supported. By default the database folder is created at the root of 
the D: drive as D:\Workgroup_Databases. All access rights are set automatically.

If you previously installed the Interplay Engine software, this field displays the share name 
that appears in the next dialog box.

n If you do not have adequate local storage for your Interplay database, you can store source files 
for file assets on a shared storage workspace rather than a local drive. To do this, you must 
perform extra steps after the installation. See “Configuring Interplay for a Split Database” in 
the Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.

The Specify Share Name dialog box opens.

8. Accept the default share name and click Next.

By default, the share name is “WG_Database$.” The “$” at the end makes the share invisible 
if you browse through the network using Windows Explorer. For security reasons, Avid 
recommends keeping the default setting and using a “$” at the end of the share name. With 
this default setting, the folder “D:\Workgroup_Databases” on the Avid Interplay Engine 
computer is shared under the name “WG_Database$.” 

The Specify Configuration Server dialog box opens.
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9. Select the Interplay Engine you want to use as the Central Configuration Server and click 
Next.

The Central Configuration Server (CCS) is an Interplay Engine with a special module that is 
useful if you are working in an environment that includes more than one Interplay Engine 
(including an Interplay Archive Engine). However, even if you are working in an 
environment with one Interplay Engine, you need to specify a CCS.

Select one of the following:

t This Avid Interplay Engine: Specifies that the Interplay Engine that you are installing 
should be the CCS. Click Next.

t Another Avid Interplay Engine: Specifies that a previously installed Interplay Engine 
should be the CCS. An additional dialog box opens. Type the name of the Interplay 
Engine to be used as the CCS and click Next.

If you want to specify another Interplay Engine, you must specify an Interplay Engine that is 
already installed. If you have not yet installed the desired Interplay Engine, specify the 
current Interplay Engine, install the desired Interplay Engine, and then change the CCS 
through the Interplay Administrator. See “Understanding the Central Configuration Server” 
in the Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.

c If you specify an Interplay Engine that is not yet installed, you might not be able to log onto 
the system. See “Troubleshooting Log-in Problems” in the Avid Interplay Engine and Avid 
Interplay Archive Engine Administration Guide.

The Server Execution User dialog box opens.
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10. Select Custom user account and click Next.

The Server Execution User is a Windows account that has administrative access to the Avid 
Interplay Engine. This account also needs to have administrative access to the shared storage 
workgroup. Avid requires that you create a custom user account. For more information, see 
“Creating the Server Execution User Account” on page 27.

The Specify Server User dialog box opens.
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a. Type a local user, for example, “IPEngine,” or type a domain user, such as 
“MYDOMAIN\IPEngine.” Make sure this user name exactly matches the user name of 
an Avid shared storage account with administrator privileges.

b. Type the password. The installer cannot check the password you type in this dialog box. 
Make sure that the password exactly matches the password for the Avid shared storage 
user with administrator privileges. If the user name and password do not match those of 
the Avid shared storage user, the Avid Interplay Engine will not run properly. Confirm 
the password.

n You can change the Server Execution User after installation. See “Troubleshooting the Server 
Execution User Account” in the Avid Interplay Engine and Avid Interplay Archive Engine 
Administration Guide.

c. Click Next.

The Specify Server Name dialog box opens. 
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11. Specify the server name as it appears on the network and click Next.

By default, the computer’s name is specified as the server name. Interplay clients use this 
name to identify the server. If there are clients in your network that are unable to resolve 
hostnames to IP addresses, you have to specify the server’s IP address here. In this case, the 
server needs a static IP address; be sure to configure your DHCP server accordingly.

n A hostname must comply with RFC 952 standards. For example, you cannot use an underscore in 
a hostname. For more information, see “Naming Conventions in Active Directory for Computers, 
Domains, Sites, and OUs” on the Microsoft Support Knowledge Base.

The server name entered should not be more than 15 characters. Server names longer than 15 
characters will be truncated and might cause problems with client connections if there is more 
than one machine in the network with the same truncated name.

The Specify Preview Server Cache dialog box opens.
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12. Accept the default location and click Next.

Interplay Access lets you view a thumbnail image or other representation of a file asset. This 
feature requires a special cache folder. The default folder for the preview server cache is 
named PreviewServer and is installed in the default database folder.

The Enable E-mail Notification dialog box opens.

13. Enable email notification and click Next.
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The email notification feature sends emails to your administrator when special events, such 
as “Disk Full” and “Out Of Memory,” occur. See “Configuring the Server Event Manager” 
in the Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide for 
details on configuring the email notification.

The E-mail Notification Details dialog box opens.

14. Supply the following information:

a. Type the administrator’s email address and the email address of the server that is the 
sender. If an event such as “Disk Full” occurs on the server, the administrator receives 
an email from the sender’s email account explaining the problem, so that the 
administrator can respond to the problem. 

b. Type the static IP address of your SMTP server. The notification feature needs the 
SMTP server in order to send emails. If you do not know this IP address, ask your 
administrator. 

c. (Option) If you also want to inform Avid Support automatically through email if 
problems arise, select the option “Send critical notifications also to Avid Support.”

d. Click Next.

The installer modifies the file Config.xml in the Avid Interplay Engine\Data\Server\Config 
directory with your settings. The Ready to Install dialog box opens.

15. If you are ready to complete the installation, click Next.
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All necessary components are installed. It might be necessary for the installation program to 
install additional components, such as Adobe Reader.

If any system libraries on your machine need to be upgraded to complete the installation 
process, the installation program asks you to reboot your machine. Save all your open 
documents, close all applications, and then click the OK button to reboot.

The installation finishes and the Installation Completed dialog box displays the success or 
failure of each installation.

16. Click Finish. 
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A dialog box requesting a reboot opens. A message with instructions on how to fix any 
installation problems also appears.

17. Click OK to reboot the machine.

18. Enable a permanent license key. See “Managing Licenses” in the Avid Interplay Engine and 
Avid Archive Engine Administration Guide for instructions. Make sure that you obtain and 
load the Interplay Engine license file promptly. The permanent license key must match the 
application key (dongle) for the Interplay Engine server.

Installing Avid Interplay Access

You must install Avid Interplay Access on the Interplay Engine. Avid recommends that you 
accept the defaults. 

Installing Avid Interplay Access also installs the Avid Interplay Administrator. 

To install Interplay Access:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Engine > Avid Interplay Access

After the installer starts, the Introduction dialog box opens.

2. Close down all other programs, then click Next. 

3. Complete the installation by accepting the defaults. If you want to install the Microsoft 
Office and Adobe Photoshop plug-ins, accept the default paths.

4. When you finish the installation, the installation program might require you to reboot the 
system. 
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Installing Software on the Interplay Transfer Server
To install Interplay software on the Interplay Transfer server:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Transfer Engine

2. Install components from the following table:

See the Avid Interplay Transfer Setup and User’s Guide for details on installing and 
configuring the Interplay Transfer software.

Component Description

Avid Service 
Framework for Client

The installer automatically installs the components required for an 
Interplay Transfer application.

Avid Interplay Access Installs the Interplay Access and Interplay Administrator applications.

Avid Interplay 
Transfer Engine

For information on configuring the Interplay Transfer server and the 
Interplay Media Services and Transfer Status application, see the 
Interplay Transfer Setup and User’s Guide.

Avid Interplay Media 
Services and Transfer 
Status

(Option) Lets you monitor Interplay Transfer jobs as well as Interplay 
Media Services jobs from any computer in the network.

Avid Interplay 
Transfer Cache 

(Option) Lets you install only the Interplay Transfer Cache. The 
Transfer Cache Engine runs in the background and allows you to 
monitor transfers in the workgroup.
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Installing Software on the Media Services and Media 
Services Provider Servers

This section provides an overview of installing the Media Services and Media Services Provider 
servers. The following illustration shows the initial installer screen.

Installing the Media Services Engine

The first screen links to the installers for Interplay Media Services. 

n Microsoft SQL Server 2005 Express is installed automatically when Interplay Media Services 
Engine is installed. After the installation of the Media Services Engine, you need to check the 
SQL Server 2005 Express configuration. See “Configuring Microsoft SQL Server 2005 Express 
(Optional)” on page 50.

To install the Interplay Media Services engine:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Media Services > Install Avid Interplay Media Services

The Install Avid Interplay Media Services window opens.
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2. Install components from the following table:

3. (Option) After you install the Media Services Engine, check the configuration of the 
Microsoft SQL Server 2005 Express. See “Configuring Microsoft SQL Server 2005 Express 
(Optional)” on page 50.

4. Configure the Media Services Engine for the Interplay workgroup.  See the Avid Interplay 
Media Services Setup and User’s Guide.

n If you are performing an upgrade, you do not have to reregister existing services such as the 
Transcode service or Archive service.

You might have to re-create some profiles after upgrading your software. See the Avid Interplay 
Media Services ReadMe.

Configuring Microsoft SQL Server 2005 Express (Optional)

Beginning with Interplay v2.3, you do not need to configure the Microsoft SQL Server 2005 
Express. Configuration is done by the Media Services installation program. Use this procedure if 
you want to check or change the configuration.

To configure Microsoft SQL Server 2005 Express:

1. Click Start and select Programs > Microsoft SQL Server 2005 > Configuration Tools > SQL 
Server Configuration Manager.

The SQL Server Configuration Manager window opens.

Component Description

Avid Service 
Framework for Client

Select the 64-bit Framework installer.

Avid Interplay Access Installs the Interplay Access and Interplay Administrator applications.

Required software to configure the Media Services Engine with the 
Avid Interplay server.

Avid Interplay Media 
Services 64 Bit

Installs the Interplay Media Services Engine.

During the installation, if an Avid Interplay Media Services database 
already exist on the server, the “Avid Interplay Database” dialog box 
opens. Select one of the following:

• Upgrade exiting database (default)—to use the existing database.

• Overwrite current database—if you want to remove all users, 
providers, and services.
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2. Select Protocols for MSSQLSERVER in the left pane.

3. Right-click TCP/IP in the right pane and select Properties.

The TCP/IP Properties dialog box opens.

4. On the Protocol tab in the General area, change Enabled from No to Yes.

Select this item
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5. Click the IP Addresses tab.

6. Do the following:

a. In the IP1 list, select Enabled and change from No to Yes.

b. In the IP2 list, select Enabled and change from No to Yes.

7. Click Apply and click OK in the message box.

8. Click OK to close the TCP/IP Properties dialog box.

Change to 
Yes.

Select Yes for Enabled

Select Yes for Enabled
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9. Do the following:

a. Select SQL Server 2005 Services in the left pane.

b. Select SQL Server (MSSQLSERVER) in the right pane.

c. Click the Restart Service button.

10. Restart the system.

n If desired, you can install the Microsoft SQL Server Management Studio Express (a graphical 
management that is part of the SQL Server 2005 Express Toolkit). You do not need to remove the 
installed SQL Server software if you want to install this tool. You can download it from the 
Microsoft web site:

www.microsoft.com/downloads/details.aspx?familyid=c243a5ae-4bd1-4e3d-94b8-5a0f62bf779
6&displaylang=en

Installing the Local Workflow Components

Use this installer screen to install the local workflow providers. For additional information, see 
the Avid Interplay Media Services Setup and User’s Guide.

To install the Local Workflow Components:

1. On the system that you want to install the provider, select the following from the Interplay 
Server Installer Main Menu.

Servers > Avid Interplay Media Services > Install Local Workflow Support

The Install Avid Interplay Media Services Local Workflow window opens.

c. Restart Service button

b. Select item.

a. Select item.

http://www.microsoft.com/downloads/details.aspx?familyid=c243a5ae-4bd1-4e3d-94b8-5a0f62bf7796&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=c243a5ae-4bd1-4e3d-94b8-5a0f62bf7796&displaylang=en
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2. You can install the following software on the Interplay Media Services system or on another 
system to improve performance:

Component Description

Avid Interplay 
Transcode

The Transcode service provider. Allows you to define profiles and 
launch transcode jobs from Access or the Avid editing application.

The Interplay Transcode installer includes an option in which you select 
whether you want to mount workspaces as drive letters or UNC paths. 
Select UNC paths if the number of workspaces required for the client 
exceeds the available drive letters. Change the server's ISIS client 
preferences match the setting you choose.

Avid Interplay STP 
Encode

Allows you to off load time-consuming processing involved in 
exporting and transferring of Long GOP OP1a media, during a 
send-to-playback request from the Avid editing application or Avid 
Interplay Assist.

n Do not install STP Encode and Interplay Transcode providers on 
the same system.

The Interplay STP Encode installer includes an option in which you 
select whether you want to mount workspaces as drive letters or UNC 
paths. Select UNC paths if the number of workspaces required for the 
client exceeds the available drive letters. Change the server's ISIS client 
preferences match the setting you choose.

Avid Interplay 
Archive Provider

The Archive provider. Typically installed on its own server. See 
“Installing the Interplay Archive Provider Software” on page 111.

Avid Interplay Copy The Interplay Copy provider. Typically installed on its own server. See 
“Configuring the Copy Provider Server” on page 165.

Avid Interplay Move Allows you to move media for Avid assets (both .mxf and .omf files) 
from one Avid ISIS workspace to another.

Avid Interplay Media 
Services and Transfer 
Status

Lets you monitor Interplay Transfer jobs as well as Interplay Media 
Services jobs on a standalone system. You don’t need to install this 
software on the Media Services system as the function is built into the 
Media Services Engine software.

Avid Interplay 
ProEncode Provider

For information on installing ProEncode, see the Avid Interplay Media 
Services Setup and User’s Guide.

(Option) Interplay 
Auto Media Services

Installs the Avid Interplay Auto Media Services. The Avid Interplay 
Auto Archive installation includes the Auto Archive, Auto Transcode, 
Auto Transfer, and Auto Copy services. 
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For information on configuring Interplay Media Services providers, see the Avid Interplay Media 
Services Setup and User’s Guide.

Installing Avid Service Framework for Local Workflow Components

The following components require the 64-bit version of Avid Service Framework for Client:

• Interplay Transcode Provider

• Interplay STP Encode Provider

• Interplay Copy

• Interplay Move

The other providers can run with either the 32-bit version or the 64-bit version of Avid Service 
Framework. See “Selecting the 32-Bit or 64-Bit Version of Avid Service Framework” on 
page 34.

c Do not install both the 32-bit Framework and the 64-bit Framework on the same system.

To install the Framework for the Local Workflow Components:

1. Navigate to the following installer page:

Servers > Avid Interplay Media Services

2. Choose the appropriate installer as follows:

- For Transcode, STP Encode, Copy, and Move, select the 64-bit Framework.

- For the other providers, select either the 32-bit or 64-bit Framework.

Installing the WAN Workflow Components

Use this installer screen to install the WAN workflow providers. The Delivery service provider 
and the Delivery Receiver service allow you to transfer clips, shotlists, and cuts only sequences 
and the media files to another workgroup. 

n You also install the Interplay Streaming server as part of the WAN workflow. See “Installing and 
Configuring the Interplay Streaming Server” on page 131.

To install the Media Services WAN Workflow Components:

1. On the system that you want to install the provider, select the following from the Interplay 
Installer Main Menu:

Servers > Avid Interplay Media Services > Install WAN Workflow Support

The Install Avid Interplay Media Services WAN Workflow window opens.
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2. You can install the following software on the Interplay Media Services system or on another 
system to improve performance:

Installing Avid Service Framework for WAN Workflow Components

Avid Interplay Delivery requires the 64-bit version of Avid Service Framework for Client:

Avid Interplay Delivery Receiver can run with either the 32-bit version or the 64-bit version of 
Avid Service Framework. See “Selecting the 32-Bit or 64-Bit Version of Avid Service 
Framework” on page 34.

c Do not install both the 32-bit Framework and the 64-bit Framework on the same system.

To install the Framework for the WAN Workflow Components:

1. Navigate to the following installer page:

Servers > Avid Interplay Media Services

2. Choose the appropriate installer as follows:

- For Interplay Delivery, select the 64-bit Framework.

- For Interplay Delivery Receiver, select either the 32-bit or 64-bit Framework.

Component Description

Avid Interplay 
Delivery

The Interplay Delivery service provider. The Delivery service provider 
and the Delivery Receiver service allow you to transfer clips, shotlists, 
and cuts only sequences and the media files to another workgroup. You 
can also use profiles to only transfer the portion that is used in a subclip.

Avid Interplay 
Delivery Receiver

The Interplay Delivery Receiver service. The Delivery Receiver service 
lets the workgroup receive transfers from a workgroup with the 
Delivery service. 
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Installing Software on an Avid Interplay Media 
Indexer Server

Different Types of Media Indexers

Avid recommends that you use one or two 64-Bit Media Indexers to monitor shared storage. You 
can add a second 64-bit Media Indexer for redundancy. For additional information and for a 
procedure for replacing existing 32-bit Media Indexers with a 64-bit Media Indexer, see the Avid 
Interplay Best Practices guide.

There are three basic ways to configure a Media Indexer:

• The leader of a High Availability Group. The leader can index shared storage and it can also 
monitor other Media Indexers. On a small configuration, the Media Indexer software might 
be installed on the Avid Interplay Engine. In this case, configure a High Availability Group 
with one member configured on the Interplay Engine.

n You always need a High Availability Group to monitor shared storage, even if it is a group of 
one.

• Additional members of a High Availability Group. Members that you add to a High 
Availability group (HAG) provide redundancy and load balancing for the leader.

• The Media Indexer on each Avid editing application system. These local Media Indexers 
connect to the High Availability Group.

n Avid Interplay Assist and Avid Instinct do not require a local Media Indexer. They automatically 
connect to the High Availability Group in the Interplay environment. You use the Server 
Hostname Settings view in the Interplay Administrator tool to identify the Workgroup name. The 
system automatically connects to the High Availability Group for the workgroup. The workgroup 
name is case sensitive and must match the workgroup name identified in the Workgroup 
Properties tool.

For information on the maximum number of files that a Media Indexer can monitor, see the Avid 
Interplay Best Practices guide and the Avid Interplay ReadMe.
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Before Installing Media Indexer Software

The following are important for a successful Media Indexer configuration:

• Before you configure Media Indexer, install the Service Framework software and verify that 
it’s running. For additional information, see “Verifying that the Service Framework Services 
Are Running” on page 103.

• Before you configure Media Indexer to monitor your Avid shared storage workspaces, the 
workspaces must have an Avid MediaFiles folder. To create the folder, you can either use an 
Avid editing application to capture or import media to the workspace or you can manually 
create an Avid MediaFiles folder.

• Do not use spaces or special characters in your workspace names.

Using UNC Drive Mapping on Interplay ISIS

On Avid ISIS, you must select the “Use UNC (Letterless) Drive Mapping” option on the Media 
Indexers that monitor shared storage. 

To set UNC Drive Mapping:

t In the ISIS Client Manager window, select Preferences and select the letterless option.

For more information, see “Mounting Workspaces as Drives: Lettered versus Letterless” on 
page 116 and “Installation Check Lists” on page 19.

Installing the Media Indexer Software

To install the Media Indexer Server:

1. Select the following from the Interplay Installer Main Menu:

Servers > Avid Interplay Media Indexer

2. Select the 32-bit or 64-bit installer.

3. Install components from the following table:

Component Description

Avid Service 
Framework for Server

Perform the installation on primary and secondary shared storage Media 
Indexers.

Avid Interplay Access Allows for easy access to the Interplay Engine. This also installs the 
Interplay Administrator.

Avid Interplay Media 
Indexer 

 Installs the Media Indexer software.
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n If you use the installer to uninstall Media Indexer, the installer exits after the uninstall is 
complete. Restart the installer to perform the installation.

Configuring a Media Indexer to Monitor Shared Storage

This procedure describes how to configure a Media Indexer be the leader of a High Availability 
Group and how to monitor shared storage. This is the basic configuration for a small system with 
only one Media Indexer. The basic procedure is as follows:

1. Identify the Media Indexer as the leader of a High Availability group.

2. Identify the shared storage locations for that Media Indexer to monitor.

For more information on using Media Indexer, see the Avid Service Framework User’s 
Guide and the Avid Interplay Best Practices guide.

Before you configure the Media Indexer, verify that the Service Framework services are running 
on the Media Indexer system. For more information, see “Before Installing Media Indexer 
Software” on page 58.

To configure the Media Indexer to monitor shared storage:

1. Click the Start button, and then select All Programs > Avid > Service Framework > 
Avid Interplay Service Configuration.

2. If more than one workgroup appears in the list, click the triangular opener next to your 
Workgroup name to open the Workgroup list.

3. On the Hosts tab, select the system that contains the Media Indexer you want to use to 
monitor shared storage, and select Avid Media Indexer.

4. Click OK when the system prompts you for the Service Framework administrator password. 
By default, there is no password. For additional information, see “Service Framework 
Administrator Password” on page 30.

A message box opens asking if you want to allow the service to run with unrestricted 
security.

5. Click Yes.

The system displays the Media Indexer information in the Avid Interplay Service 
Configuration dialog box.
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6. Click Join High Availability Group and type a name for the group. 

Perform this step even if there is only one Media Indexer for shared storage. The Media 
Indexer that monitors shared storage must be part of a High Availability group even if there 
is only one Media Indexer in the group.
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7. Click the Apply button.

8. Click the Configure button.

The system opens the Configure Storage dialog box. The following illustration shows a 
Media Indexer that is already configured to monitor folders on two workspaces.

9. Click the Add button.

The Add Storage dialog box opens.



Installing Software on an Avid Interplay Media Indexer Server

62

10. Select the Media Files Location option and click OK.

The Media Files Location dialog box opens.

11. Type the UNC path to a folder within the workspace. For example, 
\\computer_name\workspace_name\folder_name.

The following illustration shows the UNC path for the Avid MediaFiles folder on 
workspace3. The system name in this example is avid-6c85183baf.

n In general, don’t connect directly to the high level workspace name. Connect to the Avid 
MediaFiles folder or another folder in the workspace that you know contains valid Avid media 
files. This way you will avoid attempting to index non-Avid files.

12. Click Apply and click OK.

The system displays the UNC path to the folder in the Configure Storages dialog box.
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n Starting at Interplay v2.3, scanning status messages for the Media Indexer are no longer 
displayed on the Configure Storage dialog box. They are now on the Health Monitor.

n On shared storage, the Media Indexer does not recognize drive letters mapped by the user 
because it runs as a background service.

13. (Option) Click Add and repeat the process to add any additional folders.

14. Click Apply and click OK to close the Configure Storages dialog box.

The first time that you configure a storage folder, the Media Indexer automatically indexes the 
media in the folder. This might take a while depending on the amount of media in the folder.

For information on configuring the Media Indexer on an Avid editing application system to 
communicate with this shared storage Media Indexer, see “Connecting the Media Indexer on an 
Avid Editing System to the Media Indexer Monitoring Shared Storage” on page 77.

For more information, see “Different Types of Media Indexers” on page 57.

Tips for Adding a Shared Storage Workspace

If the Media Indexer Configure Storages dialog box shows Storage Not Found in the pathname 
you type, verify that you are using the UNC pathname to a folder containing Avid media files.

To check the name to use in the UNC path:

1. Open My Computer on the Media Indexer system.

2. Check the name of the computer and workspace in the display.

The following illustration shows the name for the computer and workspace names used in 
this example.
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This example requires the following UNC path for the Avid MediaFiles folder on 
Workspace1:

\\avid-6c85183baf\Workspace1\Avid MediaFiles

Installing Software on the CaptureManager Server
If this is the first time you are installing the CaptureManager software, you need to install 
Microsoft SQL Server 2005 Standard before you install the CaptureManager software. For 
installation procedures, see the Avid CaptureManager Installation and Configuration Guide and 
the Avid CaptureManager ReadMe.

To install software on the CaptureManager server:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > CaptureManager Server.

2. Install CaptureManager software. 

For information on installing and configuring CaptureManager, see the Avid 
CaptureManager Installation and Configuration Guide.

3. (Option) Install the Interplay Transfer client software.

Workspace and 
computer name 
for workspace1
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Installing and Configuring Avid Interplay Low Res 
Encoder Software

The software for updating the Avid Low Res Encoder is on the Interplay Server Installer. See the 
Interplay ReadMe for the supported version for a release.

To access the files:

1. Open the folder where you installed the Interplay Servers Installer software kit.

2. Double-click the Avid_Low_Res_Encoder folder.

For information on updating the software on the Avid Low Res Encode system, see the Avid 
Interplay Low Res Encode Setup and Configuration Guide and the ReadMe file for the 
bootset.These files are on the Interplay Server Installer in the same folder as the bootset.

Installing the Stream Publish Service and 
Auto-Publish Support

In Interplay v2.4, the Interplay Streaming Server was re-engineered to directly play 
MPEG-4/H.263 and H.264 video media and MPEG1 Layer 2 audio media. There is no longer 
any need to use the Publishing service or Workflow Engine to create QuickTime reference 
movies for streaming play. This information is provided for reference. 

n Microsoft SQL Server 2005 Express is installed automatically when the Interplay Workflow 
Engine is installed. Therefore, do not install the Interplay Workflow Engine on a system that is 
currently using the SQL database, such as the Interplay Media Services Engine system.

To install the Stream Publish service:

1. Open the folder where you installed the Interplay Servers Installer software kit.

2. Double-click the Installers folder.

3. Double-click the StreamPublish folder.

4. Double-click setup.exe and follow the instructions.

For more information, see the Avid Interplay Media Services Setup and User’s Guide.

To install the Workflow Engine and Auto Publish software:

1. Make sure the application key (dongle) is attached to the streaming server.

2. Make sure the Microsoft Automatic Update is turned off on the server that will have the 
Workflow Engine installed. You can manually install Window updates on this server.
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Microsoft Automatic Update interferes with the reconnection of the SQL database, if the 
Workflow Engine becomes disconnected.

3. OPen the folder containing the Interplay Servers Installer.

4. Double-click the Installers folder.

5. Double-click the AutoPublish folder.

6. Double-click setup.exe and follow the instructions.

The Workflow Engine and Auto Publish flow charts are installed. You need to configure 
these flow charts. For information about configuration and using auto-publish, see the Avid 
Interplay Media Services Setup and User’s Guide.



3 Installing Software on Interplay Clients

The following topics describe the Interplay software installation on Interplay clients:

• Starting the Interplay Client Installer

• Installing Software on Interplay Assist or Avid Instinct Systems

• Installing Software on an Interplay Access System

• Installing Software on Avid Editing Systems (Windows)

• Installing Software on Avid Editing Systems (Macintosh)

• Installing Software on a CaptureManager Client

• Installing Software on a Pro Tools Interplay Client
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Starting the Interplay Client Installer
To start the Interplay Client Installer:

1. In the Interplay Client Installer folder, double-click autorun.exe.

The Main Menu window opens.

The Main Menu window allows you to select the installers required by a particular Interplay 
component. The list is divided into Interplay clients and individual optional installers. 

n Items with three dots open a new window. Items without three dots start an installer.
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Installing Software on Interplay Assist or Avid 
Instinct Systems

This section describes how to install Interplay Assist or Instinct software.

To install Interplay Assist or Avid Instinct software:

1. Select one of the following from the Interplay Client Installer Main Menu:

Clients > Avid Interplay Assist

Clients > Avid Instinct

2. Install components from the following table:

n Assist and Instinct are 64-bit applications starting at Interplay v2.5. The installer pages install 
the 64-bit version of Avid Service Framework.

Interplay Assist and Avid Instinct must have ISIS or MediaNetwork client software installed on 
the same system. To use Assist or Instinct, you need to establish shared-storage credentials. This 
login happens automatically if your Windows login credentials (username and password) match 
those of a shared-storage account. If the accounts do not match, you need to connect through the 
Avid MediaNetwork Connection Manager or Avid ISIS Client Manager. You do not need to 
mount workspaces unless you are sending Long GOP sequences to playback. For more 
information, see the Interplay Assist ReadMe or the Interplay ReadMe.

Component Description

Avid Service 
Framework for Client

The installer automatically installs the components required for the 
application. When the system asks for a workgroup name, type the 
name of the workgroup you set up on the Interplay Engine. The name is 
case-sensitive.

Avid Interplay Access Installs the Interplay Access and Interplay Administrator applications.

Avid Assist Installs the Assist application software. For more information, see the 
Avid Interplay Assist User’s Guide.

Avid Instinct Installs the Avid Instinct application software. For more information, 
see the Avid Instinct User’s Guide.
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Running Interplay Assist and Editing Applications on Same System

The following limitations apply to running Assist and an editing application (such as 
NewsCutter, Media Composer®, or Avid Instinct™) on the same computer:

• If Assist is installed on the same system as Media Composer v6.0, Symphony 6.0, 
NewsCutter v10.0, or Instinct v4.0, you must install the 64-bit version of Assist.

• Because the two applications share the same libraries, the Assist release and the editor 
release must be from the same “bundle”. This means that for a given editor release you must 
install the corresponding R release of Assist (see “Avid Editing Application Compatibility 
with Interplay Releases” in the Interplay ReadMe. 

• Do not run Interplay Assist and an Avid editing application on the same computer at the 
same time. Performance and functionality are not guaranteed in this combination because 
the applications are not designed to share the computer resources.

• If you uninstall one of the applications you will uninstall some shared .dlls. In that case you 
must reinstall the application that you want to use.

Installing Software on an Interplay Access System
You can install Interplay Access on any system that you want to use to work with the 
Avid Interplay Engine. Besides installing Avid Interplay Access, this installation also installs the 
Avid Interplay Administrator.

To play streaming media, the computer on which you are installing Interplay Access must have 
an audio device, such as an audio card or other audio hardware. 

To install Interplay Access software (Windows):

1. Select the following from the Interplay Client Installer Main Menu:

Clients > Avid Interplay Access

2. Install components from the following table:

n The Service Framework is optional for an Interplay Access system.

Component Description

Avid Service 
Framework for Client

(Option) The installer automatically installs the components required 
for the application. When the system asks for a workgroup name, type 
the name of the workgroup you set up on the Interplay Engine. The 
name is case-sensitive.

Avid Interplay Access Installs the Interplay Access and Interplay Administrator applications.
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For information on using Avid Interplay Access and the Avid Interplay Administrator, see the 
following manuals:

• Avid Interplay Access User’s Guide

• Avid Interplay Engine and Avid Archive Engine Administration Guide

Macintosh Installer for Interplay Access

Interplay Access is supported on Macintosh® systems running Mac OS X. For more information 
about using Access with Mac OS X, see the Avid Interplay Access User’s Guide and the Avid 
Interplay ReadMe.

The Interplay Access installer also installs the Interplay Administrator. For more information 
about using the Interplay Administrator, see the Avid Interplay Engine and Avid Archive Engine 
Administration Guide.

For information about installing Interplay components on a Macintosh system, see “Installing 
Software on Avid Editing Systems (Macintosh)” on page 87.

To install Interplay Access on a Mac OS X system:

1. Open the Avid Interplay Clients Installer folder as follows:

- If the Interplay Clients Installer folder is located on a shared server or on a USB flash 
drive, open it from that location.

- Or copy the Interplay Clients Installers zip file to your Mac OS system and expand the 
zip file to create the Interplay Clients Installers folder. Then open the folder.

2. Open the Installers folder.

3. Copy the Mac_Installers folder to your desktop.

4. Open the Mac_Installers folder.

Three folders are displayed: Access, MediaIndexer, and TransferClient.

5. Open the Access folder and double-click the file “InterplayAccessInstallerMac.zip.”
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A program named “install.app” is expanded and displayed in the Access folder.

6. Double-click “install.app.”

The first screen of the installer program is displayed.
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7. Click Next and continue the installation.

 By default, Interplay Access is installed in the following folder:

Applications/Avid/Avid Interplay Access

If necessary, the installation program uninstalls the previous version of Interplay Access 
before it installs the current version.

To uninstall Interplay Access:

1. Delete the entire Interplay Access folder from the following location: 

Applications/Avid/Avid Interplay Access

2. Delete the Access shortcut from the Dock.

For information about installing all Interplay components on a Macintosh system or removing 
these components, see the following:

• “Installing Software on Avid Editing Systems (Macintosh)” on page 87

• “Removing Interplay Components from a MacOS X System” on page 95
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Installing Software on Avid Editing Systems 
(Windows)

Use the Avid Editor window to install Interplay components on the following systems:

• Avid NewsCutter Adrenaline and Avid NewsCutter XP

• Avid Media Composer

• Avid Symphony Nitris

Each of these Avid editing applications has its own installer for the Avid editing application 
software. This section describes how to install the components that are required by the Interplay 
environment.

To install Interplay components on an Avid editing system (Windows):

1. Select the following from the Interplay Client Installer Main Menu:

Clients > Avid Editor Support 64-Bit

2. Install components from the following table:

Component Description

Avid Service 
Framework for Client

Installs the 64-bit Service Framework. The installer automatically 
installs the components required for the application. When the system 
asks for a workgroup name, type the name of the workgroup you set up 
on the Interplay Engine. The name is case-sensitive.

Avid Interplay Access Installs the Interplay Access and Interplay Administrator applications.

Avid Interplay Media 
Indexer

Installs the 64-bit Media Indexer. You configure this Media Indexer to 
communicate with the Media Indexer monitoring shared storage. For 
more information, see “Connecting the Media Indexer on an Avid 
Editing System to the Media Indexer Monitoring Shared Storage” on 
page 77. You can also configure the Media Indexer to index your local 
drives. For more information, see “Configuring the Local Media 
Indexer to Index Local Drives” on page 82.

Avid Interplay 
Transfer Client

(Option) Installs the 64-bit Interplay Transfer Client. Install this 
software to take advantage of Interplay Transfer features such as Send 
to Playback and workgroup to workgroup transfers. For information on 
configuring the Interplay Transfer client, see the Help for your Avid 
editing application or the Avid Interplay Transfer Setup and User’s 
Guide.

Avid Interplay 
ProEncode Client

(Option) Install this software if you are using ProEncode services with 
your Interplay Media Services server.
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If the editing system is on a different subnet from the system running the Service Framework 
Lookup service, you must use Unicast Discovery to allow the editor to locate the Lookup Server 
on that subnet. For more information, see “Connecting Systems Directly to the Lookup Service” 
on page 122.

n The Avid editing applications must have either an Avid Unity MediaNetwork Connection 
Manager or Avid ISIS Client Manager installed and configured to connect to shared storage.

Moving Editors Between Interplay Systems

Each editor has a matching Interplay release. The release contains the qualified Interplay 
components for that editor. You can connect an editor to different Interplay environments but you 
must always install the qualified set of Interplay components on the editor. For additional 
information, see “Avid Editing Application Compatibility with Interplay Releases” in the Avid 
Interplay ReadMe.

Installing the Avid Service Framework Workstation Service

You have a choice of installing the regular Avid Service Framework services or installing the 
Workstation Service. The Workstation Service combines the following three services into one 
service:

• Avid Service Starter

• Avid Time Synchronization

• Avid Machine Monitor

This Service should only be installed on Avid editing application systems. If the three 
Framework services are already present, the installer replaces them with the Workstation 
Service. The installer is on the Avid Interplay Client Installer in the following location:

Installers\wgframework\Avid_Framework_Workstation

For additional information, see the Avid Service Framework User’s Guide.

Configuring an Avid Editing System in the Service Framework

After you complete the installation on each Avid editing system, verify that the Service 
Framework services are running on that system.

To verify that the Service Framework services are running:

1. Click the Start button, and then select All Programs > Avid > Avid Service Framework > 
Avid Workgroup Properties.

The Avid Workgroup Properties window opens.
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2. If your Workgroup name doesn’t appear in the Workgroup field, click the Edit button and 
type the name of the Workgroup.

n The Workgroup name can be different than the name of the computer that the Workgroup 
database is running on. This depends on how your Workgroup was originally configured. In this 
example, the Workgroup name is the same as the machine name.

If there is a green check mark next to the “Status” field, all services are running.

3. If the check mark is not green, click the Advanced button.

The Avid Interplay Services dialog box opens.

Check mark
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This dialog box allows you to view all services that are monitored by the Avid Service 
Framework. 

4. If necessary, select a service and click Start.

To verify that your system is listed in the Service Framework:

1. On any system that has the Avid Interplay Service Configuration tool installed, click the 
Start button, and then select All Programs > Avid > Avid Service Framework > Avid Service 
Configuration.

The Avid Service Configuration window opens.

2. See if the system you want to verify is listed.

3. If the system is in the list, then it is part of the Service Framework. You can optionally click 
the triangular opener next to the name and check which services are running on the system.

4. If the system you want to verify is not listed, it might be on a different subnet than the 
system running the Service Framework Lookup service. In that case, you need to use 
Unicast Discovery to allow the editor to locate the Lookup Server on the other subnet. See 
“Connecting Systems Directly to the Lookup Service” on page 122.

Connecting the Media Indexer on an Avid Editing System to the Media 
Indexer Monitoring Shared Storage

An administrator can configure the Media Indexers for the Avid editing applications on any 
system running the Interplay Service Configuration component of the Service Framework 
software.

An administrator can also use the Interplay Administrator to run the Interplay Service 
Configuration component.
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To configure the Media Indexer for an Avid editing application:

1. Do one of the following:

t Click the Start button, and then select All Programs > Avid > Avid Service Framework > 
Avid Service Configuration.

t Click the Start button, and then select All Programs > Avid > Avid Interplay Access 
Utilities > Avid Interplay Administrator. Log in to the server that is running the Avid 
Interplay Engine. In the Avid Services section, click the Service Configuration icon.

2. If more than one workgroup appears in the list, click the triangular opener next to your 
Workgroup name to open the Workgroup list.

3. Locate the Avid editing system in the list and select the Avid Interplay Media Indexer 
service. 

The following illustration shows an Avid editing system named techpub8200n.

The system prompts you for the Service Framework administrator password. By default, 
there is no password. For additional information, see “Service Framework Administrator 
Password” on page 30.

4. Click Yes, when the system displays a message asking if you want to allow the service to run 
with unrestricted security.
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5. Click Configure.

The Configure Storages dialog box opens.

6. Click Add.

The Add Storage dialog box opens.

7. Select Avid Interplay Media Indexer and click OK.
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The Avid Interplay Media Indexer dialog box opens.

8. Do the following:

a. Select Connect to a High Availability Media Indexer Group.

b. Select your group from the Group Name menu.

n Ask the Interplay system administrator for the name of the High Availability Group.

c. Select Load Balanced from the Mode menu.

d. Click Apply, and then click OK.

The system displays the high availability group in the Configure Storages dialog box.
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n If you click the triangular opener, the system displays the storage locations associated with the 
Media Indexer on shared storage.

9. Click Apply, and then click OK to close the Configure Storages dialog box.

Using the Processes Tab to Configure Media Indexers

Rather than selecting systems individually on the Hosts tab, you can also select the Processes tab 
on the Interplay Service Configuration window and configure the Media Indexers for all the 
systems on the Interplay environment from that tab. 

To use the Processes to configure the Media Indexers:

1. Click the Start button, and then select All Programs > Avid > Avid Service Framework > 
Avid Service Configuration.

2. Click the Processes tab and select the Avid Interplay Media Indexer service. 

3. Select the Avid editing system.

4. Click Configure and connect the system to the High Availability Group as described in 
“Connecting the Media Indexer on an Avid Editing System to the Media Indexer Monitoring 
Shared Storage” on page 77.
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The following illustration shows the Processes tab with the Media Indexer for shared storage 
selected.

For more information on the Media Indexer, see Avid Service Framework User’s Guide and the 
Avid Interplay Best Practices guide.

Configuring the Local Media Indexer to Index Local Drives

To configure the local Media Indexer to index your local drives:

1. Do one of the following:

t Click the Start button, and then select All Programs > Avid > Avid Service Framework > 
Avid Service Configuration.

t Click the Start button, and then select All Programs > Avid > Avid Interplay Access 
Utilities > Avid Interplay Administrator. Log in to the server that is running the Avid 
Interplay Engine. In the Avid Services section, click the Service Configuration icon.
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2. If more than one workgroup appears in the list, click the triangular opener next to your 
Workgroup name to open the Workgroup list.

3. Locate the Avid editing system in the list and select the Avid Interplay Media Indexer 
service. 

The following illustration shows an Avid editing system named techpub8200n.

4. Click OK when the system prompts you for the Service Framework administrator password. 
By default, there is no password.

5. Click Yes, in the a message box asking if you want to allow the service to run with 
unrestricted security.

6. Click Configure.

The Configure Storages dialog box opens. In the following illustration you can see that this 
Media Indexer is already connected to the shared storage Media Indexer.
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7. Select the Media Table icon and click Add.

The Add Storage dialog box opens.

8. Select Media Files Location and click OK.

The Media Files Location dialog box opens

Browse button.
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9. Click the Browse button.

n You can use the Browse button when you configure local storage but you must type a UNC path 
when you configure shared storage drives.

The Open dialog box opens.

10. Navigate to the location of your Avid MediaFiles folder. 

The following illustration shows the Avid MediaFiles folder on a MediaDock storage device.

11. Click Open.

The Media Files Location dialog box opens and displays the new location.

12. Click Apply and then click OK.

The Configure Storages dialog box opens and displays the new location.
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13. (Option) Click the Add button to add any additional storages.

14. Click Apply and then click OK to close the Configure Storages dialog box.

15. Click Apply in the Avid Service Configuration window, and then close the window.

To instruct Media Indexer to automatically recognize local drives:

1. Start the Avid editing application.

2. Select Tools > Media Creation.

The Media Creation window opens.

Local 
storage
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3. On the Drive Filtering and Indexing tab, click the “Auto-index local drives as they come 
online” button.

The local Media Indexer automatically configures Avid media files on your local drives.

n If you don’t want the Media indexer to automatically scan your local drives, deselect the 
Auto-index option.

4. (Option) Click Manual Storage Scan to start a scan.

5. (Option) Select one of the warning options. The warning occurs if the Media indexer has 
problems scanning files on the local drive.

Installing Software on Avid Editing Systems 
(Macintosh)

You can install Interplay components on Macintosh OS X systems running the following Avid 
editing products:

• Avid Media Composer

• Avid Symphony Nitris

Each of these Avid editing applications has its own installer for the Avid editing application 
software. This section describes how to install the following components that are required by the 
Interplay environment:
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n The Avid editing applications must have either an Avid Unity MediaNetwork Connection 
Manager or Avid ISIS Client Manager installed and configured to connect to shared storage.

Note the following:

• You cannot install the Avid Service Framework on the Macintosh client. You can access the 
Workgroup Properties and Service Configuration applications in two ways: 

- Through the Interplay Administrator, using either the application that is installed on the 
Macintosh client or one that is installed on another system in the workgroup. 
Double-click the Workgroup Properties icon or the Service Configuration icon in the 
main window of the Interplay Administrator.

- Through Interplay Access installed on the Macintosh client. Select View > Avid 
Workgroup Properties or View > Avid Service Configuration. 

• If you open Workgroup Properties on a Macintosh system, the Services tab does not include 
options to view the status of the Avid services running on the local computer, or to start, 
stop, restart, enable, or disable local services. For more information, see the Avid Interplay 
ReadMe.

• Avid editing applications running on Mac OS X systems require drive mapping for any 
workspaces that you use for reading or writing. For more information, see “Mounting 
Workspaces as Drives: Lettered versus Letterless” on page 116.

• You cannot use Interplay Media Services from an Avid editing application running on a Mac 
OS X system. Most Interplay Media Services are available from Interplay Access on a Mac 
OS X system.

Component Description

Avid Interplay Access Installs the Interplay Access and Interplay Administrator applications.

Avid Interplay Media 
Indexer

You configure this Media Indexer to communicate with the Media Indexer 
monitoring shared storage. For more information, see “Connecting the 
Media Indexer on an Avid Editing System to the Media Indexer Monitoring 
Shared Storage” on page 77. You can also configure the Media Indexer to 
index your local drives. For more information, see “Configuring the Local 
Media Indexer to Index Local Drives” on page 82

Avid Transfer Client (Option) Install this software to take advantage of Interplay Transfer 
features such as Send to Playback and workgroup to workgroup transfers. 
For information on configuring the Interplay Transfer client, see the Help 
for your Avid editing application or the Avid Interplay Transfer Setup and 
User’s Guide.
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To install Interplay Access on a Mac OS X system:

1. Open the Avid Interplay Clients Installer folder as follows:

- If the Interplay Clients Installer folder is located on a shared server or on a USB flash 
drive, open it from that location.

- Or copy the Interplay Clients Installers zip file to your Mac OS system and expand the 
zip file to create the Interplay Clients Installers folder. Then open the folder.

2. Open the Installers folder.

3. Copy the Mac_Installers folder to your desktop.

4. Open the Mac_Installers folder.

Three folders are displayed: Access, MediaIndexer, and TransferClient.

5. Open the Access folder and double-click the file “InterplayAccessInstallerMac.zip.”

A program named “install.app” is expanded and displayed in the Access folder.
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6. Double-click “install.app.”

The first screen of the installer program is displayed.

7. Click Next and continue the installation.

 By default, Interplay Access is installed in the following folder:

Applications/Avid/Avid Interplay Access

If necessary, the installation program uninstalls the previous version of Interplay Access 
before it installs the current version.
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To install Media Indexer on a Mac OS X system:

1. In the Mac Installers folder, open the MediaIndexer folder and double-click the file “Avid 
Media Indexer.pkg.tar.gz.”

The file “Avid Media Indexer.pkg” is unarchived and displayed in the MediaIndexer folder.

2. Double-click “Avid Media Indexer.pkg.”

A message asks if you want to continue the installation.

3. Click Continue.

The first screen of the installer program is displayed.
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4. Click Continue.

5. When prompted, enter the workgroup name and the computer name of the system running 
the Interplay Lookup service. 

c The workgroup name is case-sensitive.
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6. Continue with the installation. When prompted, enter a user name and password for an 
account that is allowed to install software.

7. When prompted, restart the system.

8. After Media Indexer is installed, configure it to communicate with the Media Indexer 
running monitoring shared storage. See “Connecting the Media Indexer on an Avid Editing 
System to the Media Indexer Monitoring Shared Storage” on page 77. 

You can also configure the Media Indexer to index your local drives. For more information, 
see “Configuring the Local Media Indexer to Index Local Drives” on page 82.

To uninstall Media Indexer, see “Uninstalling Media Indexer on a MacOS X System” on 
page 94.

To install the Interplay Transfer client on a Mac OS X system:

1. In the Mac Installers folder, open the Transfer Client folder and double-click the file 
“InterplayTransferClient.pkg.zip.”

A program named “InterplayTransferClient.pkg” is unzipped and displayed in the 
TransferClient folder.
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2. Double-click “InterplayTransferClient.pkg.”

The first screen of the installer program is displayed.

3. Click Next and continue the installation. When prompted, enter a user name and password 
for an account that is allowed to install software.

The following file is installed: 

/Library/Application Support/Avid/xfermgraphi.bundle

There is no uninstaller for the Transfer Client, so if you need to uninstall the Transfer Client, 
delete the installed file.

Uninstalling Media Indexer on a MacOS X System

To uninstall Media Indexer:

1. (Option) Stop Media Indexer (see “Stopping and Starting Media Indexer on a MacOS X 
System” on page 95).

2. Navigate to Applications > Avid Uninstallers > Avid Media Indexer and double-click 
AvidMediaIndexerUninstaller.

A terminal window opens and asks for a password. 

3. Enter a password for an administrator account and press Return. 

Media Indexer is uninstalled.

n If you close the terminal window without uninstalling the program, you can no longer use the 
terminal window. Workaround: Restart the Macintosh system.
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Stopping and Starting Media Indexer on a MacOS X System

To stop Media Indexer:

1. Open a Terminal window (select Applications > Utilities > Terminal).

2. At the prompt, type the following and press Return:

cd /Applications/Avid\ Media\ Indexer/bin

3. Type the following and press Return:

sudo ./mi.sh remove

Media Indexer is stopped. To restart it, type the following and press Return:

sudo ./mi.sh install

Removing Interplay Components from a MacOS X System

To remove all Interplay components from a MacOS X system, complete the following 
procedures.

To uninstall Interplay Access:

1. Delete the entire Interplay Access folder from the following location: 

Applications/Avid/Avid Interplay Access

2. Delete the Access shortcut from the Dock.

To uninstall Media Indexer:

1. (Option) Stop Media Indexer (see “Stopping and Starting Media Indexer on a MacOS X 
System” on page 95).

2. Navigate to Applications > Avid Uninstallers > Avid Media Indexer and double-click 
AvidMediaIndexerUninstaller.

A terminal window opens and asks for a password. 

3. Enter a password for an administrator account and press Return. 

Media Indexer is uninstalled.

n If you close the terminal window without uninstalling the program, you can no longer use the 
terminal window. Workaround: Restart the Macintosh system.

To delete the workgroup client file:

t Delete the following file:

/Library/Preferences/avid.workgroups.avid technology incorporated.plist
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To uninstall Transfer Manager:

t Delete the following file:

/Library/Application Support/Avid/xfermgraphi.bundle

Installing Software on a CaptureManager Client
To install CaptureManager client software on a CaptureManager client:

1. Select the following from the Interplay Client Installer Main Menu:

Clients > Install CaptureManager Client

The system begins the installation.

For information on installing CaptureManager and using the CaptureManager client, see the Avid 
CaptureManager User’s Guide and “Configuring Avid AirSpeed” on page 124.

Installing Software on a Pro Tools Interplay Client
The Pro Tools Interplay Client installer allows you to install Interplay Access and the Pro Tools 
Interplay Option on a Pro Tools system. The Pro Tools Interplay Option allows you to use 
Interplay to pass audio files back and forth between Avid video editing systems and Pro Tools® 
editing systems. The Pro Tools Interplay Option is supported on the Windows and Macintosh OS 
X systems that are supported by the Avid editing applications.

See the Interplay Readme, the Interplay Best Practices Guide, and the Pro Tools Avid Interplay 
Guide for details on using the Pro Tools option. The Pro Tools Avid Interplay Guide is available 
on the Avid Knowledge Base.

To install Pro Tools Interplay Client software:

1. Select the following from the Interplay Client Installer Main Menu:

Clients > Pro Tools Interplay Client

2. Install components from the following table:

Component Description

Avid Interplay Access Installs the Interplay Access and Interplay Administrator applications.

Pro Tools Interplay 
Option

This installs the following components into the Interplay Administrator 
application: “Editor Export Settings for Pro Tools” and “Pro Tools 
Import Settings.”



Installing Software on a Pro Tools Interplay Client

97

3. Before you use the Pro Tools Interplay Option, you must start Interplay Access one time to 
establish a connection to the Interplay database. See “Establishing the First Connection 
Between Pro Tools and Interplay” on page 98.

The next time you launch Pro Tools, the following menu options are available:

• File > Import > Sequence from Avid Interplay

• File > Export > Selected Tracks to Sequence in Avid Interplay

For information on using the Pro Tools Interplay Option, see the Avid Interplay Best Practices 
guide.

n You can also install this option on another system in order to make it more convenient for the 
Interplay administrator to configure the Import and Export settings.

Using the Pro Tools Send to Playback Plugin

The Pro Tools Client page also contains an installer for the Pro Tools Send to Playback plugin. 
The Pro Tools Send to Playback plugin allows you to export an AAF file directly to a third-party 
playback server for immediate live playback. This feature requires the following supporting 
software:

• Avid Service Framework 1.3 or later

• Interplay Transfer 2.4 or later

• Interplay Web Services 2.2 or later

• Pro Tools Send to Playback Plugin (available on the Pro Tools Interplay Client page of the 
Interplay Client installer)

The Pro Tools Send to Playback Plugin requires a Web Services license and installation. See 
your Avid representative for additional information. For additional information about Web 
Services, see the following Avid web page:

http://www.avid.com/us/partners/AvidInterplayAPIs

Video Satellite Support

Interplay supports the Pro Tools Video Satellite option. Video Satellite allows you to synchronize 
playback and capture between Pro Tools and either Avid Media Composer or Symphony. 

For additional information, see the Video Satellite Guide and the Pro Tools Avid Interplay Guide.
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Establishing the First Connection Between Pro Tools and Interplay

After you use the Interplay Clients Installer to install the Pro Tools Interplay Option and 
Interplay Access on your Pro Tools system, you must use Interplay Access to establish a 
connection to the Interplay database that you will be using. This is a one-time requirement that 
establishes the connection between your Pro Tools system and Interplay. Simply logging on to 
the Interplay Engine database from Access will establish the connection. Then you can exit 
Access and start using Pro Tools with Interplay.

n In order to create this initial connection between Access and Interplay, there must be an 
available license on the Interplay Engine. For example, if you have 10 Access licenses and all 10 
are being used, one person must log out of Access while you establish this initial connection.

For information on licenses and for information on using Pro Tools in an Interplay environment, 
see the Pro Tools Avid Interplay Guide and the Avid Interplay Best Practices guide.



4 Installing Optional Software

You can run individual optional installers as described in the following sections:

• Performing a Custom Install of the Service Framework Software

• Installing Avid Interplay Access or Avid Interplay Media Services and Transfer Status

• Installing Interplay Media Services Client Updater for Interplay Access

• Installing Avid Interplay Adapter

• Configuring an Interplay Adapter

Performing a Custom Install of the Service 
Framework Software

The Service Framework is used to monitor and configure the Media Indexer and the optional 
Interplay Auto Archive service. It also lets you monitor the health of other components that have 
the Service Framework installed and to view logs on the systems. For more information see the 
Avid Service Framework User’s Guide..

You install different components of the Service Framework software on different systems in the 
Avid Interplay environment. The individual installation windows automatically install all the 
components needed for the clients and servers. This installer lets you select and install specific 
components.

To install the 64-bit version of Service Framework software:

1. Select the following from the Interplay Server Installer Main Menu or the Interplay Client 
Installer Main Menu:

Individual Optional Installers

The Optional Installers window opens.
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2. Click Avid Service Framework Custom 64 Bit.

The Introduction window opens.

3. Click Next.

The Choose Install Folder window opens.

4. Accept the default values and click Next.

The Join a Workgroup window opens.
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5. Type the name of your Workgroup and click Next.

c Use the same Workgroup name on all Interplay clients. You can either use the default value 
or type a name for your Workgroup. The name is case sensitive.

c If you are updating the Service Framework software, the installer remembers the last 
installed value. If the workgroup name was changed after the install, the installer will not 
be aware of the change.

The Options window opens.
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6. Select the type of Framework installation you wish to make. 

7. Click Next.

The Custom Setup dialog box opens. This dialog box displays the components that will be 
installed. 

The following illustration shows the default components for a Framework Client install.
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If this is not the correct set of components, do one of the following:

t Click the Back button and select a different group.

t Select or deselect components from the list in the Custom Setup dialog box.

n Don’t add components that you don’t need. This can affect system performance.

8. Click Next and follow the installation instructions to complete the installation.

The installer might require that you restart your system to complete the installation.

Verifying that the Service Framework Services Are Running

You must perform these steps on each system running the Service Framework Services.

To verify that the Service Framework Services are running:

1. Click the Start button, and then select All Programs > Avid > Service Framework > 
Avid Workgroup Properties.

The Avid Workgroup Properties window opens.
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If there is a green check mark next to the “Status” field, all services are running.

2. To view the services, click the Advanced button. 

The Avid Interplay Services dialog box opens.

This dialog box lets you view all services that are monitored by the Service Framework. 

3. If necessary, select a service and click Start.

Disabling Framework Services

Depending on the system you install the Service Framework Services on, you might need to 
disable some services. 

To disable a service:

1. Click the Start button, and then select All Programs > Avid > Service Framework > 
Avid Workgroup Properties.

The Avid Workgroup Properties window opens.

2. Click the Advanced button. 

The Avid Interplay Services dialog box opens.
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3. Select the service you want to disable and click Stop.

4. After the service stops, click the Disable button to disable the service.

5. Click Exit to close the Avid Interplay Services dialog box.

6. Click OK to close the Avid Workgroup Properties window.

Installing Avid Interplay Access or Avid Interplay 
Media Services and Transfer Status

You can install Interplay Access or Interplay Media Services and Transfer Status applications on 
any qualified Windows XP system running in your Interplay environment. This lets you run the 
applications without affecting the work on other systems such as a server or an Avid editing 
system.

To install the Avid Interplay Access or Avid Interplay Media Services and Transfer Status 
software:

1. Select the following from the Interplay Server Installer Main Menu or the Interplay Client 
Installer Main Menu:

Individual Optional Installers

2. Install components from the following table:

Component Description

Interplay Access Installs the Interplay Access and Interplay Administrator applications. 
For more information, see “Installing Software on an Interplay Access 
System” on page 70.
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Installing Interplay Media Services Client Updater for 
Interplay Access

The Media Services Client Updater installer is useful if you want to use older versions of 
Interplay Access in an Interplay v2.x environment. The Client Updater updates the Media 
Services-related files used by Access and allows the older version of Access to use the Media 
Services features. However, on the systems with Access v1.5.x or v1.6.x, you won’t be able to 
use some of the new Interplay Media Services v2.x features or the Interplay Access v2.0 
features, such as playing clips from anywhere in a wide-area network (WAN) through the 
Interplay Streaming server.

n The Client Updater only supports Interplay Access v1.5.x and v1.6.x. If you install or upgrade 
Interplay Media Services clients with Interplay Access v2.x, you must upgrade the Media 
Services Engine to v2.x.

The most common example of using an older version of Access occurs when you need to run 
older versions of the Avid editing applications in your Interplay environment. Each editor 
version is qualified with a particular version of Interplay Access. For example, you can run 
Media Composer v4.0 and Media Composer v3.5 on different systems in an Interplay v2.0 
environment. However, Media Composer v3.5 requires a particular version of Access, in this 
case, Interplay Access v1.6. In this example you would run the Client Updater on the Interplay 
Access v1.6 system. Note that the Interplay Readme has a table that matches qualified releases of 
the editing applications and Interplay.

n The original files are saved during the update. If you uninstall the Avid Interplay Media Services 
Client Updater for Access, the original files are restored.

For information about preservation and batch updating of existing profiles, see the Avid Interplay 
Media Services Setup and User’s Guide. 

Interplay Media 
Services and Transfer 
Status service

This lets you view the status of Interplay Transfer and Interplay Media 
Services jobs. For information on configuring the Interplay Media 
Services and Transfer Status application, see the Avid Interplay Transfer 
Setup and User’s Guide.

Component Description
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To install the Client Updater on an Interplay Access system:

1. Install the Client Updater on all systems that are running Interplay Access v1.5.x or v1.6.x.

a. Select the following from the Interplay Server Installer Main Menu or the Interplay 
Client Installer Main Menu:

Individual Optional Installers

b. Click Avid Interplay Media Services Client Updater for Access.

The Welcome to the InstallShield Wizard for Avid Interplay Media Services Client 
Updater for Access dialog box opens.

c. Follow the steps in the Wizard to complete the installation.

2. After you complete the install, start Interplay Access and open the Media Services Status 
window.

You can now use Media Services functions and define profiles from Interplay Access.

Installing Avid Interplay Adapter
The Interplay Adapter (also referred to as the MMAdapter) is used by AirSpeed capture systems 
to connect to the Interplay Engine. In general, one Interplay Adapter can service up to 10 
AirSpeeds. Interplay Adapter is also used by CaptureManager to checkin clips to the Interplay 
database and by some third party applications for checkin and search functions.

Where you install the Interplay Adapter depends on how heavily you use your AirSpeed systems. 
If you perform many AirSpeed captures, you might want to install the Interplay Adapter on a 
CaptureManager server or on a dedicated server. For information on where to install the 
Interplay Adapter, see “Interplay Adapter and AirSpeed” on page 125.

c Do not install Interplay Adapter on an Avid Interplay Engine cluster system.

To install the Interplay Adapter:

1. Select the following from the Interplay Server Installer Main Menu:

Individual Optional Installers

2. Click Avid Interplay Adapter and follow the system prompts.

Configuring an Interplay Adapter

When you install Interplay Adapter on the Avid Interplay Engine system, it automatically 
connects to the Interplay Engine on that system. If you install Interplay Adapter on a system 
other than the Interplay Engine, you must manually edit a file to identify the Interplay Engine 
system.
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To configure Interplay Adapter to recognize Interplay Engine on a different system:

1. Use an application such as Notepad to edit the following file:

C:\Program Files\Avid\Avid Interplay Adapter\jakarta-tomcat\omm\RAM\mmserver.ini

2. Edit the following line, by replacing the text “localhost” with the computer name of the 
system running the Avid Interplay Engine:

env.ABServer=localhost

For additional information on configuring an Interplay Adapter with AirSpeed and 
CaptureManager, see “Configuring Avid AirSpeed” on page 124.

Browsing the Interplay Installer Folders
To browse the installer folders:

1. Select the following from the Interplay Server Installer Main Menu or the Interplay Client 
Installer Main Menu:.

Individual Optional Installers.

2. Click “Browse all installers.” 

3. (Option) Select any of the installers from the Installers folder, and perform a 
custom installation.



5 Installing and Configuring an Interplay 
Archive Engine

The following topics are covered in this chapter:

• Installing the Interplay Archive Engine Software

• Setting Up a Failover System

• Updating the Interplay Archive Engine Software

For more details on the Interplay Archive Engine, see the Avid Interplay Media Services Setup 
and User’s Guide.

Installing the Interplay Archive Engine Software
You need to install the following software on the Interplay Archive Engine server:

• Interplay Archive Engine

• Interplay Access

• FlashNet Client software (see Installing the FlashNet Client Software)

Additionally, you must install the Interplay Archive Provider on a separate server. See “Installing 
the Interplay Archive Provider Software” on page 111.

The Interplay Archive Engine installation is very similar to the Interplay Engine installation. The 
following are the main differences:

• It is not necessary to split the database because it is not possible to archive file assets.

• The database is called AvidAM.

• There is no temporary license key. On the Interplay Engine it is possible to connect one 
Access client to the engine when no permanent license is loaded. This is not possible on the 
Interplay Archive Engine. It is necessary to load a license before you are able to connect 
with Interplay Access. It is also necessary to load the license before you create the database. 
See “Managing Licenses” in the Avid Interplay Engine and Avid Archive Engine 
Administration Guide for instructions. 

• The AvidAM database has fewer predefined folders than the AvidWG database.
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The Interplay Archive Engine maintains a database that can be accessed through Interplay 
Access and the Interplay Administrator tool. For information on configuring the server, see the 
Avid Interplay Engine and Avid Archive Engine Administration Guide.

For information on using Interplay Access on an Archive database, or archiving from an Avid 
editing application, see the Avid Interplay Media Services Setup and User’s Guide. 

To install the Interplay Archive Engine software:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Archive Engine

The Install Avid Interplay Archive Engine window opens. 

2. Click Avid Interplay Archive to install the Interplay Archive Engine on the system. See 
“Installing the Avid Interplay Engine Software” on page 36 and start at step 6.

3. Click Avid Interplay Access to install Interplay Access on the system. See “Installing Avid 
Interplay Access” on page 47.

Installing the FlashNet Client Software

Typically your Software Generation Limited (SGL) representative installs and configures the 
FlashNet client software when he or she configures the rest of the archiving system. For 
information on using the FlashNet client, see the documentation provided by your SGL 
representative.

SGL Direct Connect to Shared Storage

Avid Interplay v2.6 and v2.7 support SGL FlashNet v6.4.x. This version of SGL FlashNet allows 
the FlashNet server to directly connect to an Avid ISIS shared-storage system through a 1-GB 
connection, dual-connected on the same subnet to the ISIS System Director in Zone 1. SGL 
FlashNet v6.4.x is qualified with Avid ISIS 7000 systems. ISIS v4.0 or later client software must 
be installed on the FlashNet server.

This configuration results in a significant performance increase for Interplay archive and restore 
operations.

Your SGL representative installs and configures the FlashNet client software on the Archive 
Provider. After installing the FlashNet client on the provider, the representative needs to create a 
registry key, as follows:

1. In a Command Prompt window, type regedit to open the Registry Editor.

2. Locate and select the following registry key: 
\HKEY_LOCAL_MACHINE\SOFTWARE\Software 
Generation\Wow6432Node\FlashNet6.
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3. Select Edit > New > String Value, name the new registry key “DETDropClient” and enter 1 
as the value. (0 specifies disabled).

4. Restart the FlashNet socket listener service.

5. Restart the provider services.

SGL FlashNet v6.4.x includes support for Simplified Chinese, which is qualified for use with 
Interplay Archive and Interplay Restore services.

Installing the Interplay Archive Provider Software

You typically install the Interplay Archive Provider software on a separate server for 
performance reasons. Install the Interplay Archive Provider from the Avid Interplay Media 
Services page of the Interplay Installer. See “Installing Software on the Media Services and 
Media Services Provider Servers” on page 49.

n The Interplay Archive Provider requires an Avid Interplay Media Services application key (also 
referred to as a dongle) with the Archive and Restore option.

To install the Interplay Archive Provider and Auto Archive software:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Media Services > Install Local Workflow Support > Avid Interplay 
Archive Provider

2. (Option) Also install Avid Interplay Auto Archive.

3. Install the Service Framework client software. Use the installer on the following page: 
Servers > Avid Interplay Media Services. See “Selecting the 32-Bit or 64-Bit Version of 
Avid Service Framework” on page 34.

For information on setting up the Interplay Archive provider and Interplay Auto Archive, see 
the Avid Interplay Media Services Setup and User’s Guide.

Setting Up a Failover System
You can configure the Interplay Archive Engine in a cluster configuration for automatic failover 
protection. For details on setting up the system, see the Avid Interplay Engine Failover Guide or 
Avid Interplay Engine Failover Guide for AS3000 Servers on the Knowledge Base.
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Updating the Interplay Archive Engine Software
When you update the Interplay Archive Engine, do not delete the software using the 
Add/Remove Programs or any other mechanism for deleting software. If you delete the software, 
the system deletes the folder structure in place at the time of the update. To update the software, 
start the Archive Engine installer on the Interplay Servers Installer and follow the installation 
instructions. The system updates the software without performing a remove operation. This 
preserves the folder structure.



6 Additional Configuration Topics

This chapter covers the following topics:

• Using Antivirus Software in an Interplay Environment

• Troubleshooting Firewalls and Avid Interplay

• Integration of Journal Data into the Database

• Mounting Workspaces as Drives: Lettered versus Letterless

• Using Time Synchronization in an Avid Interplay Environment

• Installing the Lookup Service on a Separate Server

• Connecting Systems Directly to the Lookup Service

• Configuring Avid AirSpeed Multi Stream

• Configuring Avid AirSpeed
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Using Antivirus Software in an Interplay 
Environment

Interplay v2.x supports the Antivirus and Spyware components of Symantec™ Endpoint v12.1 on 
servers and clients. 

Interplay does not support the following components:

• Proactive Threat Protection

• Network Threat Protection

The following Knowledge Base article describes how to install and configure Symantec 
Endpoint v12.1 in an Interplay environment:

Using Antivirus Software in an Interplay Environment, Support for Symantec Endpoint v12.1

Troubleshooting Firewalls and Avid Interplay

Firewalls on client machines interfere with Avid Interplay’s TCP/IP communications.

Symptoms

• The list of servers does not appear, for example, when you are connecting to a new database.

• Connection establishment to the server fails.

Cause

These problems can be caused by personal firewalls installed on the client machine. A typical 
example for such a firewall is ZoneAlarm® from ZoneLabs™ or the Windows XP, Windows 
Vista, or Windows 7 firewall. 

These applications intercept all outgoing and incoming network traffic and decide whether to let 
the traffic go through or block it. The effect is that applications like Avid Interplay fail to connect 
to their servers.

Typically when the client looks for available Avid Interplay Engines in the network, no servers 
can be retrieved. When the client is looking for servers, a UDP broadcast is sent out on port 
8321.
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Solution

Usually these personal firewalls can be configured to allow all network traffic for specific 
applications. This should be done for Avid Interplay locally or for Internet access depending on 
which servers Avid Interplay should connect to.

For information about ports used by Avid Interplay, see “Avid Interplay Port Usage” in the 
Interplay Help and the Interplay Software Installation and Configuration Guide.

Integration of Journal Data into the Database

The Interplay Engine database consists of a core database store and a single permanent journal 
file. The journal file holds the current binary data changes that are not yet written through to the 
core database. The core database and the journal file are both contained in the _Database folder. 

n Prior to Interplay version 2.1, the Interplay Engine created multiple journal files, and it was 
important for administrators to monitor the number of journal files created. This monitoring is 
not needed for Interplay version 2.1 and higher.

Both core database and journal file are used for engine operations, like ingest, searching, or 
deletion. The integration of data in the journal file into the core database is happening constantly 
in a background thread.

The journal file can grow in size when the Interplay Engine is extremely busy (for example, 
during a database schema upgrade), but will eventually shrink back to its default size (8 MB for 
the CCS database _InternalData, 32 MB for AvidWG and AvidAM). Journal integration is no 
longer suspended when a backup is performed. Therefore, journal data does not accumulate 
when a backup is running.

If a Severe Error Occurs

If a severe error occurs during integration of journal data into the core database, the Interplay 
Engine suspends the integration. Such severe error cases include:

• Failure of integration of journal data into the core database

• Failure to read/write from the journal file 

• Failure to do deletes in the streamed property store (this is a central step in the journal 
integration)

Usually in such cases, the Interplay Engine rejects all further write operations and reports an 
error code in the server log and to the clients trying to perform write operations. There are cases 
where the Interplay Engine can continue operating and adding data to the journal file, but this 
data is not integrated into the core database.
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Journal integration relies on disk access to the _Database folder at all times.

There is one point in time when the engine relies on the journal integration to be finished (at all 
other times it is done in a parallel thread). This one point is when a database is loaded, for 
example, when a database is brought up, a failover was triggered, or a cluster was taken offline 
and back online. At this point, when the database is loaded, the journal integration is enforced. 
Integration needs to go through and finish so that the database can be cleared and go online (be 
accessible by clients).

Mounting Workspaces as Drives: Lettered versus 
Letterless

Avid editing applications, Interplay Assist, and Avid Instinct require Avid shared storage client 
software to function as clients in an Avid Interplay workgroup. Explicit mounting of workspaces 
as drives might or might not be necessary, depending on your particular workflow. In general, 
there is no harm in mounting the workspaces that you need. 

The following information applies to mounting workspaces in an Interplay environment:

• Media Indexers that monitor shared storage must use UNC (letterless) drive mapping. See 
“Using UNC Drive Mapping on Interplay ISIS” on page 58.

• Avid editing applications require login to the Client Manager (Avid ISIS) or Connection 
Manager (Avid Unity MediaNetwork) to read from a workspace. (Login through the 
Connection Manager requires that you mount at least one drive.)

If your Windows username and password exactly match the Avid shared storage username 
and password, login is automatic. If your Windows username and password do not match, 
you need to log in through the Client Manager or the Connection Manager.

Drive mappings for read operations are not required except on Mac OS X systems.

n Avid editing applications running on Mac OS X systems require drive mapping for any 
workspaces that you use for reading or writing. 

• In addition to a valid login, Avid editing applications must use drive mapping for any 
workspaces that you write to.
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For Windows systems, you must use lettered drive mapping. If you do not use lettered drive 
mapping you cannot select a workspace in the Volume menu in the Capture tool, in the 
Media Creation tool, or in the Import dialog box.

• In addition to a valid login, Avid editing applications, Avid Instinct, and Interplay Assist 
require the following to use the Send to Playback feature:

- A workspace to which you have write access specified in the Editor Database Settings 
view of the Interplay Administrator, in the option “Media Creation Workspace.” 

When you send to playback, the application searches the workspaces to which you have 
write access and writes a temporary file to a Temp folder at the top level of the 
workspace with the most free storage space.

n On Interplay Assist or Avid Instinct, if your workflow includes sending Long GOP (XDCAM HD 
or XDCAM EX) media to playback, you need to mount at least one of the workspaces to which 
you have write access as a lettered drive. If you do not have at least one workspace mounted as 
lettered drive, you get an error message “Unable to find a shared storage volume for media 
transfer.” 

For more information on mounting workspaces as drives, see the Avid Unity MediaNetwork 
Connection Manager Help or the Avid ISIS Client Manager Help.

Using Time Synchronization in an Avid Interplay 
Environment

The Avid Time Synchronization Service enables time synchronization between different 
machines in a workgroup. The Time Synchronization Service can operate in either Master mode 
or Slave mode. In Master mode, the service retrieves a reference time from a configured time 
source and redistributes it to the Slave services within the workgroup. The time source can be the 
local PC clock, an NTP server, or an Adrienne timecode card installed in the server. If multiple 
Time Synchronization Services are configured as Master, they coordinate among themselves and 
identify one Primary service to distribute the time notifications (the others are in Backup mode 
and silent until a Primary fails, at which time one of the Backups takes over). In Slave mode, the 
Time Synchronization Service listens for time notifications from the workgroup and (optionally) 
sets the local PC clock to match.

n Slave Time Sync services are only useful to set the local PC clock. If you aren’t using your slave 
Time Sync to set the local PC clock, you can disable the Time Sync service on that computer.
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The following are the three typical ways of implementing Time Synchronization in an Interplay 
environment:

• In Interplay environments that use CaptureManager to capture material, a CaptureManager 
system is usually designated as the Time Sync master. The CaptureManager system has an 
Adrienne card. Install the Service Framework Time Synchronization service on the 
CaptureManager system and configure it as a Time Sync master.

• If you don’t use a CaptureManager system, do one of the following:

- Designate another system with an Adrienne card as the Time Sync master. Install the 
Service Framework Time Synchronization service on this system and configure it as a 
Time Sync master.

- Use an NTP server for Time Sync reference. Install the Service Framework Time 
Synchronization service on a system on the network that does not need to be shut down 
frequently and configure the service as a master. When you configure the master, point 
to the NTP service for time sync.

- Designate any system that rarely has to be shut down as the Time Sync master and set 
the Time sync reference to the internal PC clock on that system.

It is important to use only one time synchronism mechanism to set the local PC clocks in the 
Interplay environment. If a Time Synchronization Slave service is configured to set the local PC 
clock and it detects that some other mechanism (such as Windows 32 Time Services) changes the 
local clock, the Time Sync Slave service disables itself to avoid the local clock from jumping 
back and forth. The Time Sync slave also posts a Warning in the Health Monitor.

When you install the Time Synchronization service on a system it runs as a Time Sync slave by 
default. For information on how to configure a Time Sync master, see “Configuring the Time 
Sync Master” on page 118.

Time Sync and Log Files

All “Framework enabled” services that produce log files listen to the timestamps sent out by a 
Time Sync Master. They do this to produce a “Sync Time” field in the log files. So, even if the 
local PC clocks on all the computers do not match, the “Sync Time” field in the log files is 
always in sync across all the log files on all the machines.

Configuring the Time Sync Master

To configure the Time Sync Master:

1. Install the following Service Framework components on the system that will be used as the 
master:

- Core Components

- Configuration Utility 
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- Diagnostic Log Viewer

- Health Viewer

- Machine Monitor

- Time Synchronization 

2. On any system that has the Interplay Configuration Utility installed, click the Start button 
and select All Programs > Avid > Service Framework > Avid Interplay Service 
Configuration.

The Interplay Service Configuration window opens.

3. Select the system that will be the Time Sync master and click Avid Time Synchronization. 

The Time Synchronization Settings window opens.

4. Select options as described in the following table.

Time Synchronization Settings

Options Description

Time Stamp Interval (in 
seconds)

Determines how often the master sends out time stamp information. The 
default is 10 seconds.
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Installing the Lookup Service on a Separate Server

If you have more than 10 clients in your Avid Service Framework environment (including Avid 
editing applications, Avid Instinct, and Avid Assist), Avid strongly recommends that you put the 
Service Framework Lookup Service on a separate server such as a General Purpose Server. For 
redundancy, you may decide to set up two separate servers running the Lookup Service. The 
following section describes how to install the Lookup Service on a separate server.

To install the Lookup Service on a separate server:

1. Select the following from the Interplay Server Installer Main Menu:

Individual Optional Installers

2. Double-click Avid Service Framework Custom.

3. Follow the onscreen instructions and watch for the following items:

a. Enter your Workgroup name in the Workgroup Name window.

b. In the Options window, select “Typical Avid Interplay Server Install”.

Configuring Lookup Servers

After you complete the installation, use the Avid Interplay Service Configuration tool to check 
that the Lookup Service is not running on other Interplay Servers, particularly on Media Indexer 
servers.You can use the Avid Service Framework Workgroup Properties tool to disable the 
service on other servers.

Get Time Sync reference 
from the local PC clock

Select if you are simply using the local PC clock of one system on your 
network for time sync reference.

Get Time Sync Reference 
from an NTP server

Select when you are pointing to an NTP server on your network for time 
sync reference. 

n The NTP server does not need Service Framework software 
installed on it.

Get Time Sync reference 
from an internal Time 
Code Reader

Select when the Time Sync master system has an Adrienne timecode 
card.

n CaptureManager systems have an Adrienne card.

Time Synchronization Settings

Options Description
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For best results, connect each system running the Service Framework to the Lookup Service 
manually via the Workgroup Properties tool. This technique is called Unicast Discovery and is 
described in “Connecting Systems Directly to the Lookup Service” on page 122. Unicast 
Discovery ensures a direct connection to the Lookup Service.

Technically there is no need for Unicast Discovery on a local subnet that contains a Lookup 
Service. Unicast Discovery ensures connection to the Lookup Service but takes extra time to 
configure on a large workgroup since you have to make the connection manually on each system.

n The Avid Service Framework installer has an optional service named Multicast Repeater that 
can be used to communicate across subnets. Multicast Repeater is no longer recommended 
because it relies on a single point of communication across the subnets.

When working with multiple subnets, use Unicast Discovery on the remote subnets. Unicast 
Discovery allows for fast registration and discovery operations for systems on remote subnets.

n If you use more than one Lookup Services, use Unicast Discovery to connect to both Lookup 
Services on each machine.

Interplay System Configuration Service

Use the Interplay Service Configuration tool to check for occurrences of the System 
Configuration Service on any of your Interplay servers. This service should only run on the 
systems that contain the Lookup Service. Use the Workgroup Properties tool to disable the 
service on any other servers.

n The System Configuration service is different from the Service Configuration tool. The Service 
Configuration service runs the Interplay Service Configuration tool and can be installed on any 
system running the Service Framework.

Configuring Lookup Servers on Avid ISIS

Avid recommends that you single connect the LUS using the following guidelines:

• Single connect a LUS to each VLAN. In this case, use Unicast Discovery as follows:

- On each LUS system, open the Workgroup Properties tool, click the Lookup tab, and 
enter the fully qualified domain name of the other LUS system.

- On each client, open the Workgroup Properties tool and specify the fully qualified 
domain name of both LUS systems.

• The Interplay router needs to have a route configured between the two VLANs.

n Do not dual connect a LUS. To achieve redundancy, it is better to single connect a separate LUS 
to each VLAN.
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n There is no load balancing between Lookup Services. If you have two LUS systems they operate 
independently of each other. All Framework services register with both services. To ensure 
connectivity between subnets, use Unicast Discovery to connect all of your clients to both LUS.

Connecting Systems Directly to the Lookup Service

For systems on remote subnets, Avid recommends that you connect directly to the Lookup 
service using a technique known as Unicast Discovery. 

The main drawback to using the Unicast Discovery connection method is that if there are 
multiple systems running the lookup service, you should connect to each one. This can take a lot 
of configuration time in a large installation. If you don’t connect to all of the Lookup service 
systems, if the one you are connected to goes down you lose your connection to the Service 
Framework.

To directly connect a system to a Lookup service:

1. Determine the fully qualified domain name of the system running the Lookup service. For 
example, the following defines the domain name of the server named DocWG:

docwg.global.avidww.com

2. On the system on the remote subnet, click the Start button, and then select All Programs > 
Avid > Service Framework > Avid Workgroup Properties.

3. Click the Lookup tab.

4. Select the Workgroup that you want to connect to and click Add in the Lookup services 
window.

n If the name of the workgroup that you need does not appear in the Workgroup area, click the Add 
button and add the entry. Remember that the name is case sensitive.

5. In the Lookup services area, type in the fully qualified domain name of the system running 
the Lookup service.

6. Leave the port value at the default 4160.

7. Click Expected and click OK.

8. The domain name appears in the Lookup services area, as shown in the following example.
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n In this example, the name of the workgroup is the same as the name of the machine running the 
Lookup service.

9. Click Apply and click OK.

Configuring Avid AirSpeed Multi Stream

The AirSpeed Multi Stream is a digital recorder and playback device designed to work in an 
Avid shared storage environment. AirSpeed Multi Stream allows you to capture incoming media 
directly into Avid shared storage or play out media to air. Media can be captured directly into 
Avid shared storage workspaces unattended, freeing the Avid editing application for editing.

You use the Avid Service Framework Service Configuration tool to configure an AirSpeed Multi 
Stream. The device does not require an Interplay Adapter. However, if you use the device with a 
CaptureManager, the CaptureManager still needs the Interplay Adapter.

For more information, see the Avid AirSpeed Multi Stream Installation and User’s Guide/
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Configuring Avid AirSpeed

This section describes the settings that are specific to configuring an AirSpeed in an Interplay 
environment. For details on setting up and using AirSpeed systems, see the following documents 
on the Knowledge Base:

• Avid AirSpeed ReadMe

• Avid AirSpeed Installation and User’s Guide

• Avid AirSpeed I/O Applications User’s Guide

• Avid AirSpeed Version 2.x Supported Configurations

For information on user names and passwords required for AirSpeed, see “User Names and 
Passwords Required For Avid Shared Storage and Product Servers” on page 27.

The following illustration shows important settings in an Interplay environment.

If the Current MetaData Fmt setting is not MXF, the AirSpeed is not communicating with the 
Interplay Engine. Usually the problem is a network issue. Check the spelling of the Asset 
Manager server name and verify the IP address on the Network tab. If you need to change the 
values, restart the AirSpeed after you make the changes.

Name of the system running 
the Interplay Adapter.

For Avid Unity MediaNetwork, 
name of the Portserver. For 
Avid Unity ISIS, name of the 
System Director

Must be MXF in an Interplay 
environment
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Interplay Adapter and AirSpeed

The Interplay Adapter (also referred to as the MMAdapter) is used by AirSpeed capture systems 
to connect to the Interplay Engine. In general, one Interplay Adapter can service up to 10 
AirSpeeds. Interplay Adapter is also used by CaptureManager to checkin clips to the Interplay 
database and by some third party applications for checkin and search functions.

Where you install the Interplay Adapter depends on how heavily you use your AirSpeed systems. 
If you perform many AirSpeed captures, you might want to install the Interplay Adapter on a 
CaptureManager server or on a dedicated server. 

The following table lists the recommended systems for an Interplay Adapter installation.

If you don’t have a CaptureManager system and you have a small number of AirSpeed systems, 
you can put the Interplay Adapter on the same General Purpose Server as the Lookup Service. If 
you observe performance issues when you perform many AirSpeed captures, move the Interplay 
Adapter to another server.

For information on installing the Interplay Adapter and configuring it to recognize the Interplay 
Engine, see “Installing Avid Interplay Adapter” on page 107.

Installation Locations for an Interplay Adapter

Server Description

CaptureManager If you use CaptureManager to control your AirSpeed systems, this is the preferred 
location for an Interplay Adapter.

General Purpose Server or 
another available servera

a. Do not install the Interplay Adapter on a Media Indexer server or on an Interplay Engine cluster.

A dedicated server is the best location if you perform a lot of AirSpeed captures. 
The Interplay Adapter can also run on a server that is not carrying a heavy load. 
For example, if you have server dedicated to monitoring Interplay Transfers 
(Interplay Transfer Cache Engine), you can install the Interplay Adapter on that 
server. 

Interplay Engine 
(non-cluster only)

Only install Interplay Adapter on an Interplay Engine if you have up to a maximum 
of 10 clients in your Interplay environment (clients include Avid editing systems, 
Avid Assist, and Avid Instinct). If you find that system performance degrades when 
you perform a lot of AirSpeed captures, then move the Interplay Adapter to a 
different server.

n If you install the Interplay Adapter on an Interplay Engine, install the 
Interplay Engine software first. The Interplay Adapter installer checks for 
the presence of an Interplay Engine during the install process.
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Configuring Interplay Adapter, CaptureManager, and AirSpeed

A CaptureManager service named “Media Browse Unity Video Service” uses the Interplay 
Adapter to check assets into the Interplay database. Prior to CaptureManager v4.0.4, you could 
only have one Media Browse™ Unity Video Service running in a particular Interplay 
environment. 

Starting at CaptureManager v4.0.4, you can install a Media Browse Unity Video Service for each 
Interplay Adapter in your Interplay environment. Now if one CaptureManager server stops 
working, other CaptureManager servers can continue to check files into the Interplay database.

For additional information, see the CaptureManager v4.0.5 ReadMe.

You can now configure single or multiple Media Browse Unity Video Services to check in assets 
to the same Interplay Engine via distributed Interplay Adapters. For every Interplay Adapter 
installed, a Media Browse Unity Video Service might also be deployed that points at that 
Interplay Adapter. 

n For information on installing the Interplay Adapter and configuring it to recognize the Interplay 
Engine, see “Installing Avid Interplay Adapter” on page 107.

When you install more than one Media Browse Unity Video Service, the following 
configurations must be completed:

• If an Interplay Adapter is installed and running on a computer other than the Interplay 
Engine computer, the mmserver.ini (located, for example, in C:\Program Files\Avid\Avid 
Interplay Adapter\jakarta-tomcat\omm\RAM) must be edited to point to the Interplay 
Engine by adjusting this value: “env.ABServer=”. For more information, see “Installing 
Avid Interplay Adapter” on page 107.

• Each AirSpeed that will use a particular Interplay Adapter to check in assets must have its 
Asset Manager value (in the Setup view) configured to point to the location of the Interplay 
Adapter. 

The following illustration shows the Setup view. In this example the Interplay Adapter is 
running on the CaptureManager server named warm-capman.
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• All CaptureManager channels with an AirSpeed device must have the Media Manager Host 
Name for the AirSpeed device configured to be the same as the Asset Manager for the 
AirSpeed. 

The following illustration shows the settings in the CaptureManager Device Information 
dialog box. In this example, the Interplay Adapter is running on the same system as the 
CaptureManager so the MediaManager Host Name is the name of the local computer.

Server running the Interplay Adapter
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When you install CaptureManager, the installer asks for an Interplay Server as part of the Media 
Browse Unity Video Service configuration. 

The following illustration shows the dialog box.

Type the name of the system running the Interplay Adapter. You can also adjust the value in the 
registry at the following location:

Server running the Interplay Adapter AirSpeed device for this channel
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[HKEY_LOCAL_MACHINE\SOFTWARE\iNEWS\Media Browse\Media Browse Unity Video 
Service]

"Media Manager Host Name"=""

If the Interplay Adapter is installed on the same computer as the Media Browse Unity Video 
Service, all of the following settings use the same computer name:

• Asset Manager value in the AirSpeed Setup view.

• Media Manager Host Name setting in the AirSpeed device configuration in CaptureManager 
channel.

• Interplay Server (Media Manager Host Name) for the Media Browse Unity Video Service.

This is the case with the illustrations in this section. The Interplay Adapter is running on the 
CaptureManager server named warm-capman.

Updating Software on an AirSpeed

You can use the Software tab on AirSpeed to update software from an .ISO image on a web 
server on the network. This section describes a method that uses the Apache® web server running 
on the Avid Interplay Engine.

n Read the latest AirSpeed ReadMe before installing the AirSpeed software.

To update AirSpeed software in an Interplay environment:

1. Before you begin, obtain the .ISO image for the AirSpeed software update as described in 
the Avid AirSpeed Installation and User’s Guide. Make sure that the name follows the 
naming conventions in the AirSpeed guide.

2. Navigate to the Apache\root folder on the Avid Interplay Engine. 

3. The following table shows the location on non-cluster and cluster systems.

4. Create an iso folder in the Apache\root folder. This is a convenience; you can use any name 
for the folder.

5. Copy the .ISO image to the Apache\root\iso folder.

6. Start AirSpeed.

Non-cluster system C:\Program Files\Avid Interplay Engine\data\Apache\root

n The path to the Avid Interplay Engine folder might be different 
depending on your installation.

Cluster system S:\Workgroup_Data\Apache\root

n You must be on the active node to see the S: drive.
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7. Click the Setup button and click the Software tab.

8. Type the following in the Server text box:

Interplay_Engine/iso

where Interplay_Engine is the name of the system running the Interplay Engine. for 
example, DocWG/iso. (Note the forward slash.)

9. Press Return.

The system displays the .ISO image in the Available Versions window. 

n The system automatically locates the iso folder because it is located at the root directory of the 
Apache web server running on the Interplay Engine.

10. Select the .ISO image and click Update Version.

11. Follow the onscreen instructions. See the Avid AirSpeed Installation and User’s Guide and 
the AirSpeed ReadMe for any additional information.

Server text box

Software tab



7 Installing and Configuring the Interplay 
Streaming Server

This chapter describes how to configure the hardware on an Interplay Streaming Server, and how 
to install and configure the Interplay Streaming Server software. These procedures are described 
in the following topics:

• Interplay Streaming Server and Direct Play of Proxy Media

• Streaming Server Configuration

• Check List for Installing and Configuring the Streaming Server Software

• Upgrading Interplay Stream Server v2.3 or Earlier

• Installing and Configuring the Streaming Server Software

• Uninstalling an Interplay Streaming Server

• Changing the Name of the Interplay Streaming Server

• Changing the Name of the Streaming Server Execution User

• Installing and Configuring an Additional Streaming Server

• Searching for Streamable Master Clips
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Interplay Streaming Server and Direct Play of Proxy 
Media

In Interplay v2.4, the Interplay Streaming Server was re-engineered to directly play 
MPEG-4/H.263 and H.264 video media and MPEG1 Layer 2 audio media. There is no longer 
any need to use the Publishing service or Workflow Engine to create QuickTime reference 
movies for streaming play. Double-click a clip that is associated with supported proxy media, 
and the clip plays in the Interplay Access Monitor.

Avid Interplay Streaming Server Service

Interplay Stream Server v2.3 and earlier ran as a Windows service named Avid Interplay Stream 
Server. Interplay Streaming Server v2.4 and later runs as a Windows service named Avid 
Interplay Streaming Server Service. This service is responsible for starting and monitoring two 
Interplay Streaming Server processes. and a process called InterplayStreamingProxy.exe which 
is responsible for distributing client requests to the Interplay Streaming Server processes. These 
processes are listed in Windows Task Manager as follows:

• InterplayStreamingService.exe

• InterplayStreamingProxy.exe

• InterplayStreamingServer.exe 

• InterplayStreamingServer.exe

Activity for each of the two Interplay Streaming Server processes is written in separate log files, 
which are located in the following two folders:\\tewks-gs1s\Gold_Builds\Avid_System_Monitor

• Windows Server 2003

- drive: \Documents and Settings\All Users\Application Data\Avid\Avid Interplay 
Streaming Server\8554

- drive:\Documents and Settings\All Users\Application Data\Avid\Avid Interplay 
Streaming Server\8556

• Windows Server 2008

- drive:\ProgramData\Avid\Avid Interplay Streaming Server\8554

- drive:\ProgramData\Avid\Avid Interplay Streaming Server\8556

Configuration and Maintenance

Interplay Streaming Server v2.4 and v2.5 are qualified on both SR2500 (Windows Server 2003) 
and AS3000 (Windows Server 2008).
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Configuration and maintenance of the Interplay Streaming Server is easier without the need to 
use a shared folder to store QuickTime reference movies.

Number of Supported Streaming Clients

The Interplay Streaming Server supports up to 100 simultaneously streaming clients. This 
support applies to both SR2500 and AS3000 servers. You can add a second server to support an 
additional 100 clients. For more information, see “Installing and Configuring an Additional 
Streaming Server” on page 147.

Streaming Support for Different Interplay Access Releases

The following table summarizes streaming support for Interplay Access releases.

As shown in this table, Access v2.4 and later users can play proxy media from Streaming Server 
v2.4 (or later) or Stream Server v2.3. Access v2.3 users can only play proxy media from 
Streaming Server v2.3. 

If you are sharing streamed proxy media between Interplay v2.4 and later workgroups and 
Interplay v2.3 or earlier workgroups, Avid recommends that you upgrade Interplay v2.3 or 
earlier workgroups to Interplay Access v2.4 or later.

n The Scheduled Delete feature introduced in Interplay v2.4 requires Interplay Engine v2.4 or 
later. Other Interplay Access features introduced in Interplay v2.4 and later will operate 
correctly with Interplay Engine v2.3 or earlier.

Stream Server v2.3 in an Interplay v2.4 and later Environment

Interplay Stream Server v2.3 is supported in an Interplay v2.4 and later environment. This 
support includes support for the Interplay Publish Service and the Interplay Workflow Engine.

You can upgrade all other Interplay components to v2.4 or later while maintaining Interplay 
Stream Server v2.3. An Interplay Streaming Server v2.4 or later license is required. 

Streaming Server v2.4 and 
v2.5

(Plays proxy media directly)

Stream Server v2.3 or earlier

(Plays proxy media published as 
Quick Time reference movies)

Interplay Access v2.4 
and later

Supported Supported

Interplay Access v2.3
or earlier

Not supported Supported
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n When using Interplay Engine v2.4 or later, an Interplay Streaming Server v2.4 or later license is 
required for each streaming server in the workgroup, regardless of the version of the streaming 
server.

Identifiers for Playable Assets

Interplay Access v2.4 and later uses the following identifiers to indicate which assets are 
playable in the Monitor:

• A green triangle on the thumbnail and in the Directly Playable in Access column indicates 
the asset is fully playable.

• A partial clip icon and an orange triangle on the thumbnail and an orange triangle in the 
Directly Playable in Access column indicates the asset is playable while it is being captured.

Note the following:

• After Interplay Access starts, it takes approximately 20 to 30 seconds to check the status of 
the Interplay Streaming Server.

• Because the Playable condition is computed only when Interplay Access is populating the 
Assets window, it may take approximately 10 seconds until the Playable information is 
updated.

• If a clip is not playing but displays a playable icon, update the clip from Media Indexer and 
try playing it again.

• The property “Playable in Access” applies only to Interplay Stream Server v2.3 and earlier.

For more information about playable assets, see the Avid Interplay Access User’s Guide or the 
Interplay Help.
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Streaming Server Configuration

Interplay Streaming Server v2.4 and v2.5 are qualified on both the Intel SR2500 and the AS3000 
systems.

The following topics provide more information about configuring these systems:

• “Streaming Server Slot Locations, SR2500” on page 135

• “Streaming Server Slot Locations, AS3000” on page 136

• “Port and Firewall Usage for the Interplay Streaming Server” on page 137

Streaming Server Slot Locations, SR2500

The following illustration shows the slot locations and the network connections on an SR2500 
server.

ISIS Connections

The Interplay Streaming Server has been qualified with one network interface card (NIC) and 
with two NICs.

There is no performance benefit to dual-connecting the Interplay Streaming Server to an ISIS 
network, since there is enough bandwidth to support 100 simultaneous clients (see “Number of 
Supported Streaming Clients” on page 133). If a second NIC is required to segment your 
Streaming Server client for security purposes, then it should be connected to the outgoing 
streaming VLAN. If you use more than one NIC, you must ensure that DNS assigns the 
appropriate IP address to the Streaming Server clients and Interplay Engine.

MediaNetwork Connections

The following table lists the location for the ATTO card required for connection to an Avid Unity 
MediaNetwork

Slot 3

Slot 2

Slot 1

Slot 3

Slot 2

Slot 1

SR2500 Back Panel

ISIS NIC Optional Streaming NIC

PCIe slots PCI-X slots
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Partitions on the SR2500 Interplay Streaming Server

The SR2500 Interplay Streaming Server ships with two 500 GB drives with the following 
partitions:

• C:\ is a 60 GB partition that is mirrored across both drives.

• D:\ takes up the remaining space and is spanned across both drives. This provides roughly 
880 GB of unmirrored storage.

n If you are using the SR2500 to host an Interplay Stream Server v2.3 or earlier, you can add an 
optional expansion kit that adds 2 TB of unmirrored storage. The Expansion kit is not needed for 
Streaming Server v2.4 or later. For additional information, see the Avid Interplay Stream Server 
Expansion Kit Upgrade Readme. which is available on the Avid Customer Support Knowledge 
Base.

Streaming Server Slot Locations, AS3000

The following illustration shows the Interplay Streaming Server slot locations and the network 
connections on an AS3000 server.

SR2500 Back Panel Configuration Options for Streaming Server

Slot Type Slot Interplay Streaming Server

PCIe  3 Empty

2 Empty

1 Empty

PCI-X 3 ATTO (for Avid Unity MediaNetwork connection)

2 Empty

1 Empty

1 2

3 4

PRO/1000 PT Ports

AS3000 Back Panel

PCIe Slots
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For more information about the AS3000, see the Avid AS3000 Setup Guide.

ISIS Connections

The Interplay Streaming Server has been qualified with one network connection and with two 
network connections. Connections to the ISIS network should be through PRO/1000 PT port 2, 
port 4, or both.

There is no performance benefit to dual-connecting the Interplay Streaming Server to an ISIS 
network, since there is enough bandwidth to support 100 simultaneous clients (see “Number of 
Supported Streaming Clients” on page 133). If a second network connection is required to 
segment your Streaming Server client for security purposes, then it should be connected to the 
outgoing streaming VLAN. If you use more than one network connection, you must ensure that 
DNS assigns the appropriate IP address to the Streaming Server clients and Interplay Engine.

MediaNetwork Connection

For connection to a Avid Unity MediaNetwork, insert the qualified ATTO Fibre Channel card in 
either the top or bottom PCIe slot.

Partitions on the AS3000 Interplay Streaming Server

The AS3000 Interplay Streaming Server ships with two 1 TB (930 GB) drives that are mirrored 
by the embedded Intel RAID controller. The RAID1 array contains the following partitions:

• An unmapped 10GB recovery partition

• C:\ with 80 GB of storage

• D:\ with the remaining 840 GB of storage

If you are using the AS3000 to host an Interplay v2.3 Stream Server, you can add an optional 
expansion kit that adds 4 TB of unmirrored storage. For additional information, see the Avid 
Interplay Streaming Server AS3000 Expansion Kit Upgrade Readme. on the Knowledge Base.

Port and Firewall Usage for the Interplay Streaming Server

To enable streaming from the Interplay Streaming Server to Interplay Access clients, the network 
has to allow the following TCP and UDP traffic:

• For TCP, the network must allow direct client/server communications through server port 
554 TCP.

• For UDP packets, any firewall between Access clients and the streaming server must be 
configured either to allow RTSP/RTP traffic or to allow UDP packets between clients and 
server. The UDP streaming traffic uses dynamic random ports and not a fixed port range.

This port and firewall usage applies to both SR2500 and AS3000 servers.
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n If UDP packets are lost on the way from the server to the client there is no direct feedback. The 
Streaming Server does not get any feedback that the packets were lost, and the Access client must 
wait until a timeout occurs.

Check List for Installing and Configuring the 
Streaming Server Software

To install and configure the Interplay Streaming Server, complete the steps in the following 
check list.

Task Section Reference

 Install an Interplay license file that includes 
a license for each Interplay Streaming 
Server in the workgroup.

See “Installing a Permanent License” in the 
Interplay Engine and Interplay Archive Engine 
Administration Guide or the Interplay Help.

 Install the Avid shared storage client 
software on the system on which you are 
going to install the Interplay Streaming 
Server.

See “Set Up and Configure an Avid Shared 
Storage System” on page 23.

 Install Interplay Access on the system on 
which you are going to install the Interplay 
Streaming Server. 

Interplay Access is needed for the Media 
Indexer lookup.

“Installing Software on an Interplay Access 
System” on page 70.

 (Optional) Install the Avid Service 
Framework on the system on which you are 
going to install the Interplay Streaming 
Server.

“Installing Software on an Interplay Access 
System” on page 70.
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c After installation, exclude the folder C:\Program Files (x86)\Avid\Avid Interplay 
Streaming Server from scanning by any virus protection software. Scanning for virus 
protection could cause severe disruptions to the Interplay Streaming Server and could 
cause it to shut down. For additional information, see “Using Antivirus Software in an 
Interplay Environment” on page 114.

You can add one additional Streaming Server to a workgroup. For more information, see 
“Installing and Configuring an Additional Streaming Server” on page 147.

 Select an account that the Interplay 
Streaming Server will run under. 

You must use the Server Execution Account 
that is used for the Interplay Engine. This 
user needs to be a member of the local 
administrators group and must have the 
rights to start services. If necessary, the 
required rights for this user are 
automatically set during the installation 
process.

An account with an identical user name and 
password must have read/write access to the 
Avid shared storage workspaces that contain 
media. You use the Avid ISIS or Avid Unity 
MediaNetwork Administration tool to create 
this account.

See “Creating the Server Execution User 
Account” on page 27.

 If you are upgrading from the Interplay 
Stream Server v2.3 or earlier, remove the 
Stream Server software.

See “Upgrading Interplay Stream Server v2.3 
or Earlier” on page 140.

 Install the Interplay Streaming Server 
software.

See “Installing and Configuring the Streaming 
Server Software” on page 141.

 Specify the name of the computer running 
the Interplay Streaming Server in the 
Interplay Administrator.

See “Installing and Configuring the Streaming 
Server Software” on page 141.

Task Section Reference
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Upgrading Interplay Stream Server v2.3 or Earlier
To upgrade an Interplay Stream Server v2.3 or earlier, do one of the following:

• Disable Interplay Stream Server v2.3 components and install Interplay Streaming Server 
v2.4 or later. This procedure preserves the v2.3 components while using the new streaming 
server. The procedure is described in this topic.

• Remove Interplay Stream Server v2.3 and its components and install Interplay Streaming 
Server v2.4 or later. The procedure is described in this topic.

• Re-image the server and install Interplay Streaming Server v2.4 or later. For installation 
instructions, see “Installing and Configuring the Streaming Server Software” on page 141.

To upgrade an Interplay Stream Server v2.3 or earlier and preserve its components:

1. Disable the Interplay Stream Server and Avid Workflow Engine Service by doing the 
following:

a. For Windows Server 2003, right-click My Computer, select Manage, double-click 
Services and Applications, and double-click Services.

For Windows Server 2008, right-click the icon for your computer and select Manage.

b. In the list of services, double-click Avid Interplay Stream Server.

c. In the General Tab, click Stop, then from the Startup Type list, select Disabled.

d. In the list of services, double-click Avid Interplay Workflow Engine Service.

e. In the General Tab, click Stop, then from the Startup Type list, select Disabled.

2. If the Interplay Stream Publish service is running, close it and do not start it again.

3. Follow the instructions in “Installing and Configuring the Streaming Server Software” on 
page 141.

To upgrade an Interplay Stream Server v2.3 or earlier and remove its components:

1. Remove the Interplay Stream Server by doing the following:

a. Open Add or Remove Programs from the Windows Control Panel.

b. Select select Avid Interplay Stream Server.

c. Click Remove.

2. Remove the Workflow Engine by doing the following:

a. Open Add or Remove Programs from the Windows Control Panel.

b. Select Avid Interplay Workflow Engine.

c. Click Remove.

3. Manually delete the following folders:
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- C:\Program Files\Darwin Streaming Server

- D:\Workgroup_Streams

4. Use the Media Services and Transfer Status tool to delete the Interplay Stream Publish 
provider. For more information, see “Deleting Providers” in the Interplay Media Services 
Setup and User’s Guide or the Interplay Help.

5. Follow the instructions in “Installing and Configuring the Streaming Server Software” on 
page 141.

Installing and Configuring the Streaming Server 
Software

Before you install the Streaming Server software, review “Check List for Installing and 
Configuring the Streaming Server Software” on page 138.

For information on upgrading a stream server, see “Upgrading Interplay Stream Server v2.3 or 
Earlier” on page 140.

To install the Avid Interplay Streaming Server:

1. Select the following from the Interplay Server Installer Main Menu:

Servers > Avid Interplay Streaming Server > Avid Interplay Streaming Server

2. At the Welcome screen, click Next.

3. Read the License Agreement, click “I accept the terms in the license agreement” and click 
Next.

4. Specify the user name and password that the Interplay Streaming Server will run under (the 
Interplay Streaming Server Execution User). You must use enter a user name and password 
that exactly match the user name and password of the Server Execution User that is used to 
run the Interplay Engine. For a local account, enter the user name. For a domain account, use 
the following format:

domainname\username 

The following illustration shows an example.
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The required rights for this account are automatically set during the installation process. 

5. Click Next.

6. Specify the name of the workgroup, as specified in the Avid Service Framework.

c The workgroup name is case sensitive.

The following illustration shows an example.
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7. Click Next, then click Install to begin the installation. 

When the installation is finished, the Avid Interplay Streaming Server is running as a 
Windows service named Avid Interplay Streaming Server Service. This service 
automatically starts when the computer starts. 

To check the status of the Interplay Streaming Server:

1. Right-click My Computer and select Manage.

2. Do one of the following:

t On a Windows Server 2003 system, double-click Services and Applications, then 
double-click Services.

t On a Windows Server 2008 system, double-click Configuration, then double-click 
Services.

Avid Interplay Streaming Server Service should be listed as Started, with a startup type as 
Automatic., and with the user specified during installation in the Log On As column.

To add the Interplay Streaming Server to your Interplay workgroup: 

1. Open the Interplay Administrator and log in to the Interplay Engine server for the 
workgroup that includes the Interplay Streaming Server.

2. In the Site Settings section, click the Server Hostname Settings icon. 

The Server Hostname Settings view opens.
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3. If you are performing a new installation of the Interplay Streaming Server, do the following:

a. In the Streaming Server Settings area, click the Add button.

The Add Streaming Server and Share dialog box opens.

b. Type the computer name of the system that is running the Interplay Streaming Server. 
You do not have to type \\ before the name of the server.

c. Click OK.

The computer name is displayed in the Stream Server column.

n The share name listed does not apply to the Interplay Streaming Server v2.4 or later (it was used 
in the Interplay Stream Server v2.3 and earlier). The installer for the Interplay Streaming Server 
v2.4 or later does not create this share. However, the share name is still listed and you cannot 
remove it.

4. If you are upgrading from Interplay Stream Server v2.3 or earlier, existing stream servers are 
listed in the Stream Server Settings area. Do one of the following:

t If you are using the same computer for Interplay Streaming Server v2.4 or later, you do 
not need to replace the hostname of the server in the Server Hostname Settings view.

t If you want to install the v2.4 or later Streaming Server on a new host and keep the 
existing Stream Server as a backup, you must rename the hostname of the existing 
Stream Server. Click the Rename button, enter the name of the new host, and click OK. 
Renaming the old Stream Server avoids the need for an additional license and preserves 
indexing of reference movies if you reactivate the old Stream Server. 
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t If you want to install the v2.4 or later Streaming Server on a new host and you do not 
want to keep the existing Stream Server as a backup, click Add. Enter the name of the 
new host and press OK. Then select the old hostname, and click Remove. 

A message warns you that removing a stream server will make the reference movies 
stored on the server unplayable. Click OK.

Uninstalling an Interplay Streaming Server
Use the following procedure to uninstall Interplay Streaming Server v2.4 or later. To uninstall 
Interplay Stream Server v2.3, see “Upgrading Interplay Stream Server v2.3 or Earlier” on 
page 140.

To uninstall an Interplay Streaming Server v2.4 or later:

1. Do one of the following:

t Start the Avid Interplay Installation program, and select Servers > Avid Interplay 
Streaming Server > Avid Interplay Streaming Server. Then follow the instructions to 
remove the software.

t Open Add or Remove Programs from the Windows Control Panel, select Avid Interplay 
Streaming Server, and click Remove.

2. Manually delete the following folders:

- C:\Program Files (x86)\Avid\Avid Interplay Streaming Server

3. Remove the Stream Server from the workgroup by doing the following:

a. Open the Interplay Administrator and log in to the Interplay Engine server for the 
workgroup that includes the Interplay Streaming Server.

b. In the Site Settings section, click the Server Hostname Settings icon. 

The Server Hostname Settings view opens.

c. In the Streaming Server Settings area, select the Streaming Server you want to remove.

d. Click the Remove button.

A message warns you that removing a stream server will make the reference movies 
stored on the server unplayable. This message does not apply to Interplay Streaming 
Server v2.4 and later. 

e. Click OK.
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Changing the Name of the Interplay Streaming 
Server

If you change the computer name of the Interplay Streaming Server, you need to change the 
name in the Server Hostname Settings view in the Interplay Administrator. 

To rename an Interplay Streaming Server:

1. Open the Interplay Administrator and log in to the Interplay Engine server for the 
workgroup that includes the Interplay Streaming Server.

2. In the Site Settings section, click the Server Hostname Settings icon. 

The Server Hostname Settings view opens.

3. In the Streaming Server Settings area, click the Rename button.

The Rename Streaming Server and Share dialog box opens.

4. Type the computer name of the system that is now running the Interplay Streaming Server. 
You do not have to type \\ before the name of the server.

5. Click OK.

The computer name is displayed in the Server Hostname Settings view.

n The share name listed does not apply to the Interplay Streaming Server v2.4 and later (it was 
used in the Interplay Stream Server v2.3 and earlier). The installer for the Interplay Streaming 
Server v2.4 or later does not create this share. However, the share name is still listed and you 
cannot remove it.

Changing the Name of the Streaming Server 
Execution User

You might need to change the name of the Streaming Server Execution User. There are two 
methods, depending on the exact problem.

If you added the incorrect user/password combination during installation, you need to uninstall 
and reinstall the Interplay Streaming Server with the correct user, because in this case the 
Interplay Streaming Server service is not added to the Windows Services list. For information 
about uninstalling and reinstalling the Interplay Streaming Server, see the Avid Interplay 
Software Installation and Configuration Guide.

If the Streaming Server was correctly installed, but the Streaming Server Execution User is no 
longer available or needs to be changed for any reason, you can change the name and password 
in the Log On tab of the Streaming Server service:
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To change the name of the Streaming Server Execution User:

1. Right-click My Computer and select Manage.

2. Do one of the following:

t On a Windows Server 2003 system, double-click Services and Applications, then 
double-click Services.

t On a Windows Server 2008 system, double-click Configuration, then double-click 
Services.

3. From the list of services, double-click Avid Interplay Streaming Server Service.

4. Click the Log On tab.

5. Enter the correct user name and password.

- For local users, use the format .\<user>

- For domain users, use the format <domain>\<user>.

6. Click OK.

7. In the Services pane, click “Restart the service”.

Installing and Configuring an Additional Streaming 
Server

You can add one additional Interplay Streaming Server to a workgroup. Adding a second 
Interplay Streaming Server can increase the number of simultaneous streaming clients to 200. 
See “Number of Supported Streaming Clients” on page 133.

To install an additional Streaming Server

t Follow the instructions in “Installing and Configuring the Streaming Server Software” on 
page 141. Both computer names will be displayed in the Server Hostname Settings view.

Searching for Streamable Master Clips
The Advanced Search attribute Streamable Masterclips was designed to find master clips that 
were published for streaming (select the value “are published”) or qualified for streaming but not 
yet published (select the value “are not published”). The Streamable Masterclips attribute is most 
useful when searching Interplay v2.3 and earlier databases. Note that you cannot use this 
attribute to search for streamable subclips or sequences. 
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You can use the Streamable Masterclips attribute when searching an Interplay 2.4 or later 
database to find clips that are associated with qualified proxy resolutions (MPEG-4/H.263 video, 
H.264 video, and MPEG1 Layer 2 audio). Create a search that uses the following criteria:

Streamable Masterclips are published AND Media Status is online

OR

Streamable Masterclips are not published AND Media Status is online

To search for streamable master clips in Interplay v2.4 or later, you can also use the Extended 
Search feature to search for clips that are associated with one or more qualified proxy resolutions 
and save the search criteria for reuse.



8 Workgroups with Multiple ISIS Systems

The following topics describe support for multiple ISIS systems in a single workgroup: 

• Understanding Multiple ISIS Workgroups

• Check List for Adding Multiple ISIS Systems to a Workgroup

• Requirements for Multiple ISIS Workgroups

• Adding Remote ISIS Systems to ISIS Client Software

• Adding Remote ISIS Systems in the Interplay Administrator

• Configuring Media Indexer for Additional ISIS Systems

• Mounting ISIS Workspaces as UNC Paths

• Working with Media Services and Interplay Transfer in a Multiple ISIS Workgroup

Understanding Multiple ISIS Workgroups
Interplay v2.6 introduces support for up to three ISIS shared-storage systems managed by a 
single Interplay Engine and configured in a single workgroup. Using multiple ISIS systems 
allows you to expand available storage for your Interplay Production workgroup. 

Previous versions of Interplay limited a workgroup to one shared-storage system. Interplay v2.6 
allows you to integrate one or two additional ISIS shared-storage systems, for a total of three.

Interplay Move v2.6 can be used for high-speed transport of media between multiple ISIS 
systems. For more information, see “Working with Media Services and Interplay Transfer in a 
Multiple ISIS Workgroup” on page 159.

A 10-Gb switch and 10-GB connections are recommended as high-bandwidth links between the 
ISIS systems. For more information, see “Requirements for Multiple ISIS Workgroups” on 
page 154 and the following configuration example.

Local ISIS System and Remote ISIS Systems

An Interplay workgroup requires one ISIS shared-storage system that shares the same subnet 
with the Interplay workgroup. This ISIS system is considered the local system. You can use the 
ISIS client software on the Interplay Engine to add an ISIS system that exists on a different 
subnet. This ISIS system is considered a remote system.
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The following illustration shows an example of a multiple ISIS configuration. The local ISIS 
system is an ISIS 7000, dual-connected to an Avid network switch through subnets VLAN 10 
and VLAN 20 (Zones 1 and 2). The remote ISIS system is an ISIS 5000, single-connected 
through VLAN 30, a different subnet on the same switch (Zone 3). A Media Indexer is 
dual-connected to the same subnets as the Interplay Engine and local ISIS system. This Media 
Indexer is configured to scan both the local ISIS system and the remote ISIS system.

n This illustration shows one example of an Interplay network configuration. Other configurations 
are also supported if each ISIS System Director is in its own Zone 3 subnet.

Limitations

• Each workspace name in the workgroup must be unique. There can be no duplicate 
workspace names across the multiple ISIS systems.

This restriction is especially important when using Interplay Access for tasks that require 
reference to a workspace, such as delete and search. In those parts of Interplay Access that 
require a workspace name, you cannot specify a shared-storage server name, only a 
workspace name.

You can view complete path for files, including the shared-storage server and workspace, in 
the File Locations tab of the Object Inspector.

LEGEND

Multiple ISIS Configuration

Media Indexer 1 GB Ethernet Connection

ISIS 7000 System Director

 ISIS Client Software

ISIS 7000 Drive Arrays
ISIS 5000
System Director and Drive Arrays

 Interplay Engine
 ISIS Client Software

10 Gb Ethernet Connection

VLAN 10 VLAN 20 VLAN 30

Local System Remote System
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• The Interplay Media Indexer application must run on an AS3000 server in order to monitor 
multiple ISIS systems. Media Indexer v2.6 on an AS3000 server can index up to 5 million 
files on ISIS shared storage, which sets the limit for the number of files supported in a 
multiple ISIS workgroup. You can use the Media Indexer web-based user interface to view 
the file count. The value (Files) is displayed in the Statistics window as shown in the 
following illustration.

For more information, see Avid Interplay What’s New in V2.6.

• There can be only one copy of a media file in the entire workgroup. The Copy service is not 
supported for copying assets from one ISIS system to another within the same workgroup.

• Adding additional ISIS systems does not increase the number of ISIS clients that are 
supported in the workgroup.

• Interplay Central is not supported in a multiple ISIS workgroup.

Avid Editing Systems Support

Users of Avid editing applications (NewsCutter, Media Composer), Interplay Assist, and Avid 
Instinct can edit using media from any ISIS system to which they have access. On each system, 
the ISIS client software must be configured for additional ISIS systems. See “Adding Remote 
ISIS Systems to ISIS Client Software” on page 155.

Playback of a sequence with clips from different ISIS systems is not officially qualified. Avid has 
not tested performance characteristics for mixing media of any resolution from more than one 
storage configuration in a sequence.
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Media Creation Workspaces

The Media Creation Workspace setting in the Interplay Administrator sets the workspace used 
for media clips created by Instinct and Assist users, such as voice-over recordings and clips 
created during send-to-playback operations. Beginning with Interplay v2.6, the displayed 
workspaces include the hostname of the shared-storage server in a UNC path. All existing 
settings are retained as part of an upgrade to v2.6 and you do not need to change them.

For a multiple ISIS workgroup, the Media Creation Workspace setting is affected in the 
following ways:

• If you do not list shared-storage servers for Avid ISIS Authentication in the User 
Authentication view of the Interplay Administrator, the Media Creation setting shows 
accessible workspaces for all ISIS systems that are configured through the ISIS client on the 
Interplay Engine. 

• If you list shared-storage servers for Avid ISIS Authentication in the User Authentication 
view of the Interplay Administrator, the servers that you specify determine which 
workspaces are displayed. This occurs whether or not ISIS user authentication is activated. 
For example, if you specify SysDirector_A, only workspaces on SysDirector_A are listed. If 
you specify SysDirector_A and SysDirector_B, workspaces on both systems are listed. See 
“Adding Remote ISIS Systems in the Interplay Administrator” on page 157.

n The UNC paths are not displayed until the first time you set or change the Media Creation 
Workspace setting.

AirSpeed Server Support

AirSpeed Multi Stream and AirSpeed 5000 server support: 

• Simultaneous send-to-playback operations from multiple ISIS systems are supported (v1.8.x 
and later). 

• Recording to a remote ISIS system is not supported.

AirSpeed Classic is not supported.
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Check List for Adding Multiple ISIS Systems to a 
Workgroup

Use this checklist to add one or two remote ISIS systems to a workgroup that already includes a 
local ISIS system.

Task Section Reference

 Review the requirements for adding a remote 
ISIS system.

“Requirements for Multiple ISIS Workgroups” 
on page 154

 Integrate the additional ISIS system or 
systems into the network.

“Understanding Multiple ISIS Workgroups” on 
page 149, Avid Products and Network Site 
Preparation Guide, and the Setup Guide for the 
ISIS system.

 Upgrade to Interplay v2.6. Avid Interplay Version 2.6 ReadMe

 When upgrading Interplay Transcode and STP 
Encode, select the option to mount 
shared-storage drives as UNC paths.

“Mounting ISIS Workspaces as UNC Paths” on 
page 159

 Create accounts for the Server Execution User 
and Interplay users on each additional ISIS 
system.

Avid ISIS documentation

 Add each additional ISIS system to the ISIS 
Client Manager on the Interplay Engine.

“Adding Remote ISIS Systems to ISIS Client 
Software” on page 155.

 For Unity authentication, specify the server 
name of each additional ISIS system in the 
Interplay Administrator.

“Adding Remote ISIS Systems in the Interplay 
Administrator” on page 157.

 Configure Media Indexer for each additional 
ISIS system.

“Configuring Media Indexer for Additional ISIS 
Systems” on page 156 and Avid Interplay 
Software Installation and Configuration Guide. 
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Requirements for Multiple ISIS Workgroups
Avid ISIS Hardware and Software Configurations

Currently up to three ISIS shared-storage systems are supported for a single workgroup. The 
following models are supported, in any combination:

• ISIS 2000 systems

• ISIS 5000 systems

• ISIS 7000 systems

Avid ISIS v4.0 or later server and client software is required.

Each additional ISIS System Director must be in its own Zone 3 subnet (see “Understanding 
Multiple ISIS Workgroups” on page 149).

Avid recommends that all ISIS systems are connected through a 10-Gb network. The network 
topology should be determined by the site requirements.

Interplay Software

All components in the workgroup must be running Interplay version 2.6.

Accounts

The Interplay workgroup and both ISIS systems must include matching user accounts as follows:

• Server Execution User: An account with a user name and password identical to the Server 
Execution User must exist on the ISIS system. This account must have read/write access to 
the Avid shared storage workspaces that contain media. Use the Avid ISIS Administration 
tool to create this account.

• Interplay and ISIS users: Accounts with identical user names and passwords must exist on 
the Interplay system and the ISIS system. 

- The ISIS user account must have read/write privileges on the workspaces you want to 
move from and move to.

- The matching Interplay user account must have read/write privileges on the folders you 
want to move from and move to. 

Media Indexer

Storage for each additional ISIS system needs to be configured in a Media Indexer running on an 
AS3000 server. All Media Indexers need to be configured in one high-availability group (HAG). 
For more information, see “Configuring Media Indexer for Additional ISIS Systems” on 
page 156.
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Adding Remote ISIS Systems to ISIS Client Software
After the local ISIS system is installed and configured, use the Avid ISIS Client Manager on the 
Interplay Engine to add a remote ISIS system.

To add a remote system:

1. Start the Avid ISIS Client Manager by clicking Start > All Programs > Avid > ISIS Client.

2. Click the Remote Host Settings button, as shown in the following illustration.

The Remote Hosts dialog box opens.

3. Enter the hostname for the remote ISIS server and click the Add (+) button.

The ISIS server appears in the Host list.
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4. Click the Apply button (green check mark) and close the dialog box.

The remote host is listed in the Systems list.

Configuring Media Indexer for Additional ISIS 
Systems

One Media Indexer (MI) can index two or more ISIS systems in the same Interplay workgroup. 
The following limitations apply:

• Each MI in the High Availability Group (HAG) must have access to all available ISIS 
workspaces. For information on setting up and configuring ISIS systems, see the Avid 
Products and Network Site Preparation Guide and the Setup Guide for your ISIS product.

• Configure the ISIS client on the MI to recognize all available ISIS systems. Use the ISIS 
Client Manager to connect to additional ISIS systems, as described in “Adding Remote ISIS 
Systems to ISIS Client Software” on page 155.

• Configure the leader of the HAG to see all of the storage locations that you want to access on 
both ISIS systems, as described in the Avid Interplay Software Installation and 
Configuration Guide. For example, the following illustration shows connections to the 
workspaces on two ISIS systems. The two System Directors are named A51-wg1-sd1 and 
BSI-Multi-ISIS.
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Adding Remote ISIS Systems in the Interplay 
Administrator

If your workgroup is configured for Avid Unity Authentication, you need to specify each 
additional ISIS server name in the User Authentication Providers view of the Interplay 
Administrator. Users can then use their Avid ISIS credentials to log in to the Interplay database 
and access any additional ISIS servers to which they have access.

For more information, see “Setting Avid Unity Authentication” in the Avid Interplay Engine and 
Avid Interplay Archive Engine Administration Guide or the Interplay Help.
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n If you list ISIS server names for Unity authentication, the servers that you specify determine 
which workspaces are available in the Media Creation Workspace setting.This occurs whether or 
not ISIS user authentication is activated. See “Media Creation Workspaces” on page 152.

To configure additional shared-storage systems for Unity Authentication in the Interplay 
Administrator:

1. In the User Management section of the Interplay Administrator window, click the User 
Authentication Providers icon.

The User Authentication Providers view opens.

2. Click Avid ISIS Authentication.

3. Click the Add Avid ISIS button.

4. Type the System Director hostname for the additional Avid ISIS systems.

Click the Remove Entry button to delete a hostname.

5. Click Apply.

The first time an Avid ISIS user logs into Interplay, the user is added to the Central 
Configuration Server (CCS) as part of the UNITY user group under Imported Users, with 
Read rights by default.

n In the Server Hostname Settings view of the Interplay Administrator, there is a setting for 
Fallback Shared-Storage Server. In most cases the name of the local ISIS system is entered 
automatically. If you need to manually enter the computer name, use the name of the System 
Director for the local ISIS system. 
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Mounting ISIS Workspaces as UNC Paths
A multiple ISIS configuration is likely to have a large number of workspaces. Mounting 
workspaces as UNC paths provides the ability to mount more drives than the number of drive 
letters available. 

Mounting workspaces as UNC paths is required for the Move and Copy services.

Starting with version 2.6, the Interplay Transcode service and the STP Encode service require 
you to choose how ISIS workspaces are mounted: by drive letter or by UNC path. For multiple 
ISIS workgroups, select UNC path. After installation, configure the ISIS Client Manager to use 
UNC paths.

Working with Media Services and Interplay Transfer 
in a Multiple ISIS Workgroup

Most Media Services and Interplay Transfer profiles include a setting for shared-storage 
workspaces. If you are adding remote ISIS systems to an existing workgroup, your existing 
profiles will work correctly with the workspaces as they are currently defined. The following 
sections supply information about creating new profiles.

Move v2.6 and Other Media Services

Interplay Move v2.6 supports high-speed transfer of media between multiple ISIS systems. A 
10-GB network is recommended. Existing profiles will work correctly with the workspaces as 
currently defined. For a new or edited profile that specifies a workspace on a remote ISIS system, 
the workspace path must include the hostname of the ISIS System Director and the name of the 
workspace, in the standard UNC format:

\\hostname\workspace_name

The following illustration shows an example, in which a51-wg1-sd1 is the System Director for 
the target ISIS system, and Highest_Copy is the target workspace.
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For more information, see “Working with the Move Service” in the Avid Interplay Media 
Services Setup and User’s Guide.

Use the same format for workspaces in other Media Services profiles, such as Delivery and 
Transcode when the target workgroup includes multiple ISIS systems. Existing profiles will 
work correctly with the workspaces as currently defined, but new or edited profiles that specify a 
workspace on a remote ISIS system must include the hostname of the ISIS System Director.

Interplay Transfer v2.6

Interplay Transfer uses an ISIS workspace for incoming transfers. For easier workspace 
management, you should include the System Director hostname in a UNC path in the “No-login 
workspace for incoming transfers” setting in the Avid Interplay Transfer Engine Configuration 
dialog box.



A SR2500 Slot Locations

The Intel® SR2500 is a supported servers for the Interplay applications. This section shows the 
front and back view and describes the slot locations that are specific to the Interplay components.

• SR2500 Front View

• SR2500 Slot Locations

For information about slot locations for the AS3000, see Migrating Interplay Applications to 
AS3000 Servers.

SR2500 Front View

The front view of the two servers is identical. The following illustration shows the front view and 
control panel.

The following table describes the control panel shown in the previous figure.

Control panel

DVD/CD-ROM

RAID disk (ID 1)

System disk (ID 0)

A

B
C D E F

G

H

I

JL K

SR2400 and SR2500 Front View
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SR2500 Slot Locations

The SR2500 is supported as a server for the Interplay applications. This section describes the slot 
locations that are specific to the Interplay components.

Use the following figure and tables as guides to how your SR2500 is configured in an Interplay 
environment. Notice that Interplay Engine cluster systems support two Infortrend RAID arrays. 
The Infortrend A16F-R2431 is the newer model.

n It’s important to match the slot locations in the following tables because they match the order 
that the drivers are loaded on the SR2500 Recovery DVDs.

System Director Control Panel

Letter Description Letter Description

A Power/Sleep button G System ID LED (blue, a second system 
ID LED is on the rear)

B NIC 2 activity LED H System ID button (System ID LED 
blinks when pressed)

C NIC 1 activity LED I System reset button

D Power/Sleep LED J USB 2.0 connector

E System status LED K Recessed NMI button (need tool)

F Internal drive activity LED L Video connector

Slot 3

Slot 2

Slot 1

Slot 3

Slot 2

Slot 1

PCI-X slotsPCIe slots
SR2500 Back Panel

Primary power 
supply on bottomSerial A to F/C switch if needed

Keyboard
RJ 45 to 
serial B

1 Gig 
Enet

Video

USB

1 2

Mouse

Power supplies
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SR2500 Back Panel Configuration Options for Avid Unity MediaNetwork

Slot 
Type  Slot

Interplay Engine 
and othera 
Interplay servers

a. Includes servers for Interplay Archive Engine, Interplay Media Indexer, Interplay Media Services, 
Transcode Providers, and General Purpose Server.

Interplay Engine Cluster and 
Archive Engine Cluster

Interplay Transfer, 
Archive Providers, and 
ProEncode

PCI-X  3 ATTO • Empty (Infortrend A16F-R2431)

• ATTO (Infortrend A16F-R221)

ATTO 

2 Empty Empty Emulex 1050b

b. Install Emulex 1050 for use with Interplay Transfer/Profile.

1 Empty • ATTO FC-41XS to Infortrend 
A16F-R2431

• QLogic Card to Infortrend 
A16F-R221

PRO/1000 MF/XFc

c. Install PRO/1000 MF or XF as optical options for use with Interplay Transfer/AirSPACE.

PCIe  3 Empty Empty Empty

2 Empty PRO/1000 PT PRO/1000 PTd

d. Optional replacement for Intel PRO/1000 MF or XF.

1 Empty • ATTO FC-41EL to MediaNetwork 
(Infortrend A16F-R2431)

• Empty (Infortrend A16F-R221)

Empty
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n For slot locations on the Copy Provider server, see “Copy Provider Slot Locations” on page 165. 
For slot locations on the Interplay Streaming server, see “Streaming Server Slot Locations, 
SR2500” on page 135.

n For information on configuring an Infortrend RAID Array, see the Avid Interplay Failover Guide.

SR2500 Back Panel Configuration Options for Avid ISIS

Slot Type Slot 

Interplay Engine and 
othera Interplay 
servers

a. Includes servers for Interplay Archive Engine, Interplay Media Indexer, Interplay Media Services, 
Transcode Providers, and General Purpose Server.

Interplay Engine Cluster and 
Archive Engine Cluster

Interplay Transfer, 
Archive Providers, 
and ProEncode

PCI-X  3 Empty Empty PRO/1000 XF/MFb

b. Install PRO/1000 MF or XF as optical options for use with Interplay Transfer/AirSPACE.

2 Empty Empty Emulex 1050c 

c. Install Emulex 1050 for use with Interplay Transfer/Profile.

1 Empty • ATTO FC-41XS to Infortrend 
A16F-R2431

• QLogic Card to Infortrend 
A16F-R221

Empty

PCIe 3 Empty Empty Empty

2 Empty PRO/1000 PT PRO/1000 PTd

d. Optional replacement for Intel PRO/1000 MF or XF.

Empty Empty Empty



B Configuring the Copy Provider Server

This chapter describes how to set up the hardware and ISIS client information on a Copy 
Provider server on an Intel SR2500 server. The following topics are described:

• Copy Provider Slot Locations

• Chelsio Adapter Board Installation

• Chelsio Driver Installation

• ISIS Connections and Client Software Installation

• Client Manager Preference Setting

• Configure Chelsio as the Default Network Connection on the Copy Provider

• Creating Copy Provider User Accounts for ISIS and Interplay

For information about configuring the AS3000, see Migrating Interplay Applications to AS3000 
Servers.

Copy Provider Slot Locations

The Chelsio™ Ethernet adapter cards are PCIe cards. This section shows the slot locations for the 
Chelsio cards in an SR2500 server.

For information about slot locations in the AS3000, see Migrating Interplay Applications to 
AS3000 Servers.

Slot 3

Slot 2

Slot 1

Slot 3

Slot 2

Slot 1

PCI-X slotsPCIe slots
SR2500 Back Panel

Primary power 
supply on bottomSerial A to F/C switch if needed

Keyboard
RJ 45 to 
serial B

1 Gig 
Enet

Video

USB

1 2

Mouse

Power supplies
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n You can use the onboard nics instead of Chelsio adapter boards, but performance is much better 
when using the Chelsio adapter boards. See “ISIS Connections and Client Software 
Installation” on page 169.

Chelsio Adapter Board Installation
The following information summarizes the Chelsio 10 Gb adapter board installation.

Before you install the Chelsio adapter boards you must replace the long brackets that are 
attached to the board with the shorter brackets that come in the kit.

n Avid recommends that you prepare the adapter boards one at a time to ensure that you replace 
the SFP+ transceiver into the same adapter board that you removed it from.

To prepare the Chelsio adapter boards for installation:

1. Remove the SFP+ transceiver from the back of the Chelsio adapter board as follows:

a. Remove the rubber insert protector from the transceiver.

b. Flip open the latch on the end of the transceiver.

c. Pull out the transceiver and set it aside.

The following illustration shows the SFP+ transceiver with the latch open.

SR2500 Back Panel Configuration Options for Copy Provider

Slot Type Slot Interplay Copy Provider

PCI-X  3 Empty

2 Empty

1 Empty

PCIe 3 Empty

2 Chelsio 10 Gb adapter board

1 Chelsio 10 Gb adapter board
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c Be sure to replace the transceiver into the same board you removed it from. 

2. Remove the two screws that hold the long bracket to the adapter board. Set the screws aside.

3. Remove the bracket.

4. Attach the short bracket and reattach the two screws.

5. Replace the SFP+ connector as follows:

a. Slide the transceiver into the slot until it clicks into place.

b. Close the latch and replace the rubber insert.

6. Perform the same steps for the second Chelsio adapter board.

Screw holding bracket to the 
adapter board

Transceiver with open latch
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To install the Chelsio adapter boards:

1. Shutdown the server.

2. Remove the top from the SR2500 server.

3. Remove the plastic Processor Air Duct.

4. Remove the PCI add-in card riser assembly.

5. Open the latch on the PCIe side of the PCI add-in card riser assembly and remove the plates 
for slots 1 and 2. See “Copy Provider Slot Locations” on page 165.

6. Insert the Chelsio adapter boards in PCIe slots 1 and 2. 

7. Close the latch on the PCIe side of the PCI add-in card riser assembly.

8. Replace the PCI add-in card riser assembly. Use care to avoid pinching system cables. Press 
down firmly until the three hooks on the rear of the PCI riser assembly engage the chassis 
panel slots.

9. Replace the Processor Air Duct. Use care to avoid pinching system cables.

10. Replace the top of the SR2500 server.

11. Restart the server and continue with “Chelsio Driver Installation” on page 168.

Chelsio Driver Installation
After installing the Avid Chelsio 10 Gb adapter boards, you need to install the Chelsio drivers. 
The drivers are located on the ISIS Installer DVD.

 After the SR2500 system has restarted, the system displays the Found Hardware Wizard.

To install the Chelsio driver:

1. In the Found Hardware wizard for the “Ethernet Controller” dialog box, click Cancel and 
close the Hardware wizard.

2. A second Found Hardware Wizard will appear for the second adapter board. Click Cancel 
and close that Hardware Wizard also.

3. Insert the ISIS Installer DVD into the DVD drive.

4. Navigate to the [DVD drive]:\Tools_3rdParty\Drivers_andFirmware\Chelsio folder, and 
double click the following to launch the Chelsio driver installer.

AvidChelsioDriversx86.exe (for 32 bit systems)

5. Follow the on-screen prompts and restart the SR2500 when finished.

n You will receive several messages stating that you are installing an unsigned driver. Each time 
the dialog box appears, click “Continue Anyways”.
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n Do not configure Ultra High Resolution settings in the Client Manager preferences. For more 
information, see “Client Manager Preference Setting” on page 172.

ISIS Connections and Client Software Installation

The following illustration shows the basic workflow for copying metadata and media files. The 
Copy Provider copies metadata from one Interplay Engine to another, and copies media files 
from one ISIS shared storage system to another. This example shows a configuration that is used 
for copying media in either direction (from Workgroup 1 to Workgroup 2, or from Workgroup 2 
to Workgroup 1), so a Media Services Engine and Copy Provider are required in each 
workgroup.

Each Copy Provider must be directly connected to both ISIS systems.

Avid 
Editing
System

Interplay
Access

Interplay
Engine

Avid 
Editing
System

Interplay
Access

Interplay
Engine

Media
Services
Engine

Copy 
Provider

ISIS
Storage

Interplay Workgroup 1 Interplay Workgroup 2

Media

Metadata

The Copy Provider copies
metadata to the Interplay Engine 
and media files to ISIS storage.

Media
Services
Engine

Copy 
Provider

ISIS
Storage

From Workgroup 1 to Workgroup 2

From Workgroup 2 to Workgroup 1

Metadata

Media
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When directly connecting the 10-Gb Ethernet fibre adapter board into the ISS 10-Gb port on the 
Avid ISIS Engine, each link between the two workgroups must be within the maximum distance 
shown in the following table.

As a result, the distance between two workgroups can be twice the maximum cable length.

For more information on cabling for Avid ISIS, see the Avid Products and Network Site 
Preparation Guide. If you want to copy media to another workgroup when the workgroups are 
located beyond the maximum cable length, you must use Interplay Transfer.

Making the ISIS Connections

This section describes how to make the ISIS connections.

c For best performance, do not connect two Copy Providers to the same ISIS chassis. If you 
have more than one Copy Provider, connect each to a different ISIS chassis.

Using the Chelsio Adapter Boards

When using the Chelsio adapter boards, connect the Chelsio adapter boards directly into the ISS 
10-Gb ports on the Avid ISIS Engines. Connect the Copy Provider to both Avid ISIS systems.

Using the Default 1GB Onboad Nics on the Copy Provider

When using the 1 GB onboard nic on the Copy Provider, connect the 1 Gb ports on the Copy 
Provider directly into any 1 Gb port on the Avid ISIS Engines. Connect the Copy Provider to 
both Avid ISIS systems. Avid does not recommend using the onboard nics because performance 
is much better using the Chelsio adapter boards.

10-Gb Cable (MMF 50 micron cable)
Maximum Cable Length 
(Copy Provider to ISIS)

500 MHz*km (Overfilled Launch Bandwidth, typical of OM2 cable) 82 m

2000 MHz*km (Effective Modal Bandwidth, typical of OM3 cable) 300 m

4700 MHz*km (Effective Modal Bandwidth, typical of OM4 cable) 550 m

ISIS #1 ISIS #2
Copy
Provider

Max 300m
   (OM3)

Max 300m
   (OM3)

Max 600m
   (OM3)



ISIS Connections and Client Software Installation

171

Copy Provider ISIS Configurations

Each ISIS Engine (also known as an ISIS chassis) supports a maximum of two Copy Providers:

• One for sending material to a remote workgroup

• One for receiving material from a remote workgroup

If you have multiple ISIS chassis in your workgroup, you can set up multiple sending and 
receiving providers. 

The following illustration shows Copy Providers configured between two workgroups.

Copy Provider and ISIS Versions

The ISIS systems must be running compatible versions of ISIS software. For compatibility 
information, see the Interplay ReadMe.

Installing the ISIS Client Software

This section describes how to install the ISIS client software.

Chassis 1

Chassis 2

Copy
Providers

Chassis 1

Workgroup A Workgroup B

ISIS ISIS

Chassis 2

Chassis 1

Copy
Providers

Chassis 1

Workgroup A Workgroup B

ISIS ISIS

Chassis 2 Chassis 2

Example 1 One send and one receive can use a single chassis on each workgroup

Example 2 Two simultaneous sends requires two chassis.
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To install the ISIS Client software:

t Use the Avid ISIS installer DVD to install the ISIS client software. 

The Avid ISIS System Quick Start Card, located in the top-level Avid ISIS Documentation 
folder on the Avid ISIS installer DVD, contains instructions for installing Avid ISIS client 
software. See the ISIS ReadMe for additional information about installing the client 
software on your system.

Client Manager Preference Setting
The Copy Provider server with Chelsio boards installed does not require the Ultra High 
Resolution setting in the Client Manager Preferences. Setting the Ultra High Resolution setting 
can affect performance on the Copy provider. Use the default Medium setting. If you need to 
change the setting to Medium, use the following procedure.

To select the Medium Resolution:

1. Start Client Manager software and open the Preferences window.

The preferences window opens, and the General section is displayed by default.

2. In the client type drop down, select “Medium.”

3. Click Apply.

4. Click the Network icon from the left pane.

5. Verify that the Chelsio boards appear in the network interfaces list and that Enabled is 
selected.

6. Click the Configure button.

The Chelsio Network Card Settings window opens.

7. Verify that all of the options are selected.

8. Click OK to close the Network Card Settings window.

9. Click the Close button to close the Preferences window.
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To set ISIS login preferences:

t Set up the login preferences as OS Log in with Auto Connect.

Configure Chelsio as the Default Network 
Connection on the Copy Provider

This section describes how to use the ISIS Client Manager network preferences to disable the 
other network interfaces.

To ensure that the Chelsio connections are the primary connection:

1. Start the ISIS Client Manager application.

2. Open the Preferences window.

3. Click the “Network” button from the left pane of the Preferences Window.

A list of all valid ISIS network connections are listed.

4. In the Description Column find the two Chelsio Connections and make sure these line items 
are Enabled. The following illustration shows the two Chelsio adapter boards enabled.

Configure button
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5. Disable each of the other listed adapters by clicking the checkbox in the Enable column to 
clear it. This ensures that the Chelsio adapter boards are the only connections used for ISIS 
traffic.

6. Click the Configure button associated with the Chelsio adapter and verify that the Network 
Card Settings window has all four boxes checked.

n Disabling a network card in the Client Manager Preferences only makes the card unavailable to 
Unity ISIS. It does not affect the card’s functionality in the operating system or any other 
applications.

Creating Copy Provider User Accounts for ISIS and 
Interplay

Both ISIS systems and both Interplay workgroups must include matching user accounts as 
follows: 

• Both ISIS systems and both Interplay workgroups must include matching user accounts. The 
user name and password for these accounts must match exactly. 

- The ISIS user account must have read/write privileges on the workspaces you want to 
copy from and copy to.

- The Interplay user account must have read/write privileges on the folders you want to 
copy from and copy to.

The following table summarizes the locations where you must create matching accounts and 
where they are used. 

Avid recommends that you use the same Central Configuration Server (CCS) for both 
workgroups to make user management easier. For more information on the CCS, see the 
Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.

• You must connect the Copy Provider to both ISIS systems through the same account. The 
workspaces must be mounted using letterless drive mappings. 

Account Where used

ISIS user in Workgroup A

ISIS user in Workgroup B

ISIS Client Manager on Copy Provider

Interplay user in Workgroup A

Interplay user in Workgroup B

Interplay Access on Interplay Engine
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The following illustration shows the ISIS Client Manager with Composer1 connected to two 
different workgroups.



C Configuring the Move Provider Server

This chapter describes how to set up the hardware and ISIS client information on a Move 
Provider server on an Intel SR2500 server. The Move provider is used to move files from one 
ISIS workspace to another.

n The Move feature works only within a single workgroup with a single ISIS System Director. To 
copy assets and media to a different workgroup, use the Copy Provider.

The following topics are described:

• Move Provider Slot Locations

• Chelsio Adapter Board Installation

• ISIS Connections and Client Software Installation

• Client Manager Preference Setting

• Configure Chelsio as the Default Network Connection on the Move Provider

• Creating Move Provider User Accounts for ISIS and Interplay

For details on setting up and using the Move Provider, see the Avid Interplay Media Services 
Setup and User’s Guide and the Avid Interplay Access User’s Guide.

For information about configuring the AS3000, see Migrating Interplay Applications to AS3000 
Servers.



Move Provider Slot Locations

177

Move Provider Slot Locations

The Chelsio™ Ethernet adapter card is a PCIe card. This section shows the slot location for the 
Chelsio card in an SR2500 server.

For information about slot locations in the AS3000, see Migrating Interplay Applications to 
AS3000 Servers.

The Move Provider runs Windows XP Professional and is set up similarly to the Interplay 
Transcode provider.

SR2500 Back Panel Configuration Options for Move Provider

Slot Type Slot Interplay Move Provider

PCI-X  3 Empty

2 Empty

1 Empty

PCIe 3 Empty

2 Empty

1 Chelsio 10 Gb adapter board

Slot 3

Slot 2

Slot 1

Slot 3

Slot 2

Slot 1

PCI-X slotsPCIe slots
SR2500 Back Panel

Primary power 
supply on bottomSerial A to F/C switch if needed

Keyboard
RJ 45 to 
serial B

1 Gig 
Enet

Video

USB

1 2

Mouse

Power supplies
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Chelsio Adapter Board Installation
For information on installing the Chelsio card and drivers, see “Chelsio Adapter Board 
Installation” on page 166 and “Chelsio Driver Installation” on page 168.

ISIS Connections and Client Software Installation

The Move Provider must be directly connected to the ISIS system, using a 10 Gb Ethernet 
connection. For more information on cabling for Avid ISIS, see the Avid Products and Network 
Site Preparation Guide. 

To make the ISIS connections:

t Connect the Chelsio adapter board directly into the ISS 10-Gb port on the Avid ISIS Engine.

To install the ISIS Client software:

t Use the Avid ISIS installer DVD to install the ISIS client software. 

The Avid ISIS System Quick Start Card, located in the top-level Avid ISIS Documentation 
folder on the Avid ISIS installer DVD, contains instructions for installing Avid ISIS client 
software. See the ISIS ReadMe for additional information about installing the client 
software on your system.

n For best performance, the ISIS system must be running Avid ISIS v2.0.3 or later. 

Client Manager Preference Setting
Do not use the Ultra High Resolution setting in the Client Manager Preferences. Setting the Ultra 
High Resolution setting can affect performance on the Move provider. Use the default Medium 
setting. If you need to change the setting to Medium, use the following procedure.

To select the Medium Resolution:

1. Start Client Manager software and open the Preferences window.

The preferences window opens, and the General section is displayed by default.

2. In the client type drop down, select “Medium.”

3. Click Apply.

4. Click the Network icon from the left pane.

5. Verify that the Chelsio board appears in the network interfaces list and that Enabled is 
selected.

6. Click the Configure button.
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The Chelsio Network Card Settings window opens.

7. Verify that all of the options are selected.

8. Click OK to close the Network Card Settings window.

9. Click the Close button to close the Preferences window.

To set ISIS login preferences:

t Set up the login preferences as OS Log in with Auto Connect.

n Keep the ISIS Management Console Device bandwidth setting for the Move and Copy providers 
at the default 0 setting. Leaving it at 0 will allow the Move provider to use the maximum 
bandwidth available.

Configure Chelsio as the Default Network 
Connection on the Move Provider

This section describes how to use the ISIS Client Manager network preferences to disable the 
other network interfaces.

To ensure that the Chelsio connection is the primary connection:

1. Start the ISIS Client Manager application.

2. Open the Preferences window.

3. Click the “Network” button from the left pane of the Preferences Window.

A list of all valid ISIS network connections are listed.

4. In the Description Column, locate the Chelsio Connection and make sure the line item is 
Enabled. 

5. Disable each of the other listed adapters by clicking the checkbox in the Enable column to 
clear it. This ensures that the Chelsio adapter board is the only connection used for ISIS 
traffic.
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6. Click the Configure button associated with the Chelsio adapter and verify that the Network 
Card Settings window has all four boxes checked.

n Disabling a network card in the Client Manager Preferences only makes the card unavailable to 
Avid ISIS. It does not affect the card’s functionality in the operating system or any other 
applications.

Creating Move Provider User Accounts for ISIS and 
Interplay

The following accounts are required for the Move operation: 

• The ISIS user account must have read/write privileges on the workspaces you want to move 
from and move to.

• The Interplay user account must have read/write privileges on the folders you want to move 
from and move to.

For additional information on creating accounts, see the Avid ISIS Administration Guide and the 
Avid Interplay Engine and Avid Interplay Archive Engine Administration Guide.



D Installing Cards on the Interplay Transfer 
Server

This chapter covers the following topics:

• Interplay Transfer Server Slot Locations

• Installing Cards in the Interplay Transfer Server

Interplay Transfer Server Slot Locations
For information on Interplay Transfer slot locations, see “SR2500 Slot Locations” on page 161.

For information about slot locations in the AS3000, see Migrating Interplay Applications to 
AS3000 Servers.

Installing Cards in the Interplay Transfer Server

For information about configuring the AS3000, see Migrating Interplay Applications to AS3000 
Servers.
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The cards included with the Interplay Transfer server depend on the Avid shared storage 
environment where the Interplay Transfer server is being installed.

• In an Avid ISIS environment, the Interplay Transfer server might ship with an Intel® 
PRO/1000 Server Adapter gigabit card, depending on your system’s configuration. This card 
must be installed in slot 3 (top slot). Follow the directions supplied with the card. For 
information on configuring the Intel PRO/1000 card, see “Configuring the Intel PRO/1000 
Adapter Card” on page 182. 

• In an Avid Unity MediaNetwork environment, the Interplay Transfer server might ship with 
an Intel PRO/1000 Server Adapter gigabit card and an ATTO™ Fibre Channel card, 
depending on your system’s configuration. These cards must be installed in the appropriate 
slots:

- Install the Intel PRO/1000 Server Adapter card in slot 1 (bottom slot of SR2500) of the 
Interplay Transfer server. Follow the directions supplied with the card. For information 
on installing the Intel PRO/1000 driver, see “Configuring the Intel PRO/1000 Adapter 
Card” on page 182. 

- Install the ATTO Fibre Channel card in slot 3 (the top slot) of the Interplay Transfer 
server. Follow the directions supplied with the card.

Configuring the Intel PRO/1000 Adapter Card

For information about configuring the AS3000, see Migrating Interplay Applications to AS3000 
Servers.

The Intel PRO/Adapter card might require the installation of the Intel Pro/1000 driver. After you 
install the driver, you need to configure the card to work correctly with the Interplay Transfer 
server. This section provides procedures for installing the driver and configuring the card for 
Jumbo Frames.

To install the Intel PRO/1000 driver:

1. Install the Intel PRO/1000 server adapter card and restart your system.

A message might appear, looking for the Intel PRO/1000 driver. 

2. Open the C:\IntelPro folder.

3. Click the Autorun.exe file.

The Intel Pro Network Connections window opens.

4. Click Install Drivers.

5. Click Finish.
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To configure the Intel PRO/1000 card for Jumbo Frames:

1. Right-click the My Network Places icon, and select Properties.

2. Right-click the file for the Intel Pro interface used by Interplay Transfer and select 
Properties.

3. Click Configure.

4. Click the Advanced tab.

5. In the Property area, select Jumbo Frames.

6. In the Value area, select 9014Bytes.

7. Click OK.
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The following table lists networks ports used by Interplay. It does not include ports used by 
shared storage (Avid ISIS, MediaNetwork or Lanshare). This information is useful to network 
administrators when configuring the network and firewalls, setting up ISIS Zone 3 clients, and 
resolving network conflicts.

n If you are transferring material between different sites, you must open port 80 on the Firewall of 
the receiving site in order to allow communication with the Interplay Engine. This is required for 

Avid Interplay Port Usage

Component and Location Port Protocol Purpose

Access 8321 UDP Server Browser.

80 TCP Server communication.

Access can also be a Media Indexer client 
(update media status, Resync), Media Services 
client (status tool plugin and submit jobs to 
archive and Transcode), and Transfer Engine 
client (status tool plugin, initiate WG2WG 
transfers); see appropriate sections.

Active Directory 135 TCP RPC for Active Directory / Windows Domain 
Authentication.

Archive Provider 1433 TCP #Microsoft-SQL-Server (ms-sql-s).

These values are for SGL 
connections. For other third party 
archive solutions, see the third 
party documentation.

1433 UDP #Microsoft-SQL-Server (ms-sql-s).

1434 TCP #Microsoft-SQL-Monitor (ms-sql-m).

1434 UDP #Microsoft-SQL-Monitor (ms-sql-m).

8192 TCP #FlashNetBackupClient (sdss).

Assist Assist uses Access ports for Interplay engine 
communication. It is also a Media Indexer 
client. See appropriate sections for port usage.
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Cluster Service 135 TCP RP; also used by Distributed Link Tracking 
Server - Service Name TrkSvr and Distributed 
Transaction Coordinator - Service Name 
MSDTC).

Random TCP Randomly allocated high TCP ports; also used 
by Distributed Link Tracking Server - Service 
Name TrkSvr and Distributed Transaction 
Coordinator - Service Name MSDTC).

3343 UDP Cluster Services (service name: ClusSvc).

Delivery Service 33321  TCP Command port. Also identified in the Interplay 
Administration tool under Server Hostname 
Settings.

20020-21020 TCP Data ports. To change the default port numbers, 
see the Media Services Setup and User’s Guide.

DNS 53 UDP/TCP DNS Client.

iNews 21 FTP FTP into iNEWS database: Teleprompters, 
NewsCutter newsroom system tool, Data 
Receiver.

22 SSH ssh.

25 sendmail.

67 Used by PCU's to obtain an IP address via 
bootp.

80 http Web Access, for read-only database access.

513 rlogin.

600 FTP into Linux partition.

698 Might be required for Web access through 
cgi-bin.

699 Used by dbvisit (maintenance program) for 
on-line dbvisits.

1019 Server listens for client connections.

Avid Interplay Port Usage 

Component and Location Port Protocol Purpose
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1020 Server updates/notifications to client, specified 
by client. Each client running on a machine 
must bind to a unique socket. If a user intends 
to run N sessions of iNEWS on the same 
machine, then ports 1020 through 1020 + (N-1) 
must be opened in the firewall (TCP and UDP).

1022 iNEWS bioserver communication.  More often 
used on 2-server systems, but might use 
loopback.

1023 Used by connect command during startup.

5901 First remote access port for VNC to Linux UI, 
might have more than one VNC session 
configured (5902, 5903, and so on).

6100 FTS indexing (configurable).

6101 FTS searching (configurable).

6825 Monitor, for ControlAir.

6826 Monitor for MOS.

49152 TELNET Telnet.

Instinct Instinct uses Access ports for Interplay engine 
communication. It is also a Media Indexer 
client. Instinct E3is also an iNEWS client. See 
appropriate sections for port usage. 

Interplay Engine 8321 UDP Server Browser.

80 TCP Client communication.

Interplay Streaming Server 554 TCP Direct client/server communications

Service Framework / Media 
Indexer

Ports are dynamic and services register 
themselves with firewall to use any port.

dynamic (0 - 
1024)

TCP Codebase http server. 

dynamic TCP Jini™ ERI ServerConnectionManager.

Avid Interplay Port Usage 

Component and Location Port Protocol Purpose
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dynamic - 
above 1024

TCP Jini ERI ConnectionManager.

dynamic TCP/ UDP TCP/UDP notifications.

4160 TCP Jini Discovery.

4160 UDP Jini Discovery.

LDAP 389 TCP

636 If SSL is enabled.

Media Services Engine 8080 TCP Listen for editor clients (SOAP).

1099 TCP Listen; RMI protocol for providers and 
Status/Admin tool.

42000-42060 TCP If 1099 not available. 

Media Services Providers / Status 
Tool

1099 TCP Outbound; RMI protocol for providers and 
Status/Admin tool.

42000-42060 TCP If 1099 not available. 

NewsCutter 21 Required for NRCS tool.

8080 TCP Outbound; Media Services connection to Media 
Services Engine (SOAP).

NewsCutter uses Access ports for Engine 
communication. It also runs the Service 
Framework and a local Media E3Indexer; see 
appropriate sections for port usage.

ProEncode Client 8080 TCP/IP SOAP Connection to Media Services (TCP, 
outbound) - run on editing systems 
(NewsCutter).

Transfer Cache 1099 TCP Listen; RMI protocol for providers and 
Status/Admin tool.

42000-42060 TCP If 1099 not available. 

6539 TCP Outbound for Transfer Engine status.

Avid Interplay Port Usage 

Component and Location Port Protocol Purpose



187

Transfer Engine 6532 TCP/IP Media Connectivity tool (defined in 
system32\drivers\etc\services com.avid.mct). 
The TM server listens on this port for requests 
from other TM servers (for example, initiating a 
workgroup transfer.).

6535 TCP/IP Playback protocol (defined in 
system32\drivers\etc\services com.avid.pbp). 
This is the default port used by TM Server for 
connecting to Playback Servers (Airspace etc.). 
This is configurable for some playback servers.

6539 TCP/IP Transfer Engine (defined in 
system32\drivers\etc\services com.avid.pbp 
com.avid.xmgr). The TM Server listens on this 
port for incoming requests from the TM Client.

Avid Interplay Port Usage 

Component and Location Port Protocol Purpose
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